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อาจารย์ทีป่รึกษาโครงงาน  :  ………………………………………………………………… 
           ( อ. วษุิวฒัก ์ แตส้มบติั ) 
          ………./………./………. 
 

การศึกษาคร้ังน้ีได้ทาํการจาํลองการไหลเขา้ท่วมของนํ้ าในพื้นท่ี โดยการนาํขอ้มูลระดับ
พื้นผิวดินจากแบบจาํลองทางกายภาพของระบบลุ่มนํ้ าของภาควิชาวิศวกรรมชลประทาน ซ่ึงใช้การ
สาํรวจเก็บค่าระดบัพื้นผิวดินดงักล่าวโดยใชห้ลกัการเดียวกนักบัระบบ LIDAR (Light Detection and 
Ranging) ซ่ึงเป็นระบบสํารวจรังวดัระดบัความสูงภูมิประเทศดว้ยแสงเลเซอร์ท่ีติดตั้งบนอากาศยาน 
โดยไดท้าํการประยุกตร์ะบบดงักล่าวโดยใช้เคร่ืองมือวดัระดบัเลเซอร์ติดตั้งกบัโครงเหล็กท่ีสามารถ
เล่ือนไดใ้นแนวระนาบ โดยค่าท่ีอ่านไดจ้ากเคร่ืองมือวดัระดบัดงักล่าวซ่ึงเป็นค่าความลึกจะถูกแปลง
ไปเป็นค่าความสูงพื้นผิวภูมิประเทศ (DEM: Digital Elevation Model) แลว้นาํขอ้มูล DEM ดงักล่าว
มาใชเ้ป็นขอ้มูลดา้นเขา้ของแบบจาํลอง MIKE21 ในการจาํลองการไหลของนํ้าในแบบ 2 มิติ 
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ABSTRACT 
 
Title : Flow simulation of the physical model of River Basin by using MIKE21 Model 
 
By : Mr. Chaloempon   Turntaisong 
 
Project  Advisor : …………………………………………………………….. 
               ( Mr. Wisuwat  Taesombat ) 
                 ………./………./………. 
 
 The study aimed to simulate flood inundation in the river basin. The physical model of 
river basin created by the department of Irrigation Engineering was used as the study area. The 
ground surface elevations of this model were derived by following LIDAR method which observed 
the ground elevations by laser detection equipment installed in the airborne. In this study, the 
LEICA DISTOTM classic5 A was used to observed the elevations of the physical model in associate 
with the horizontal steal holding which was installed over the physical model. The derived 
elevations were converted to DEM (Digital Elevation Model) data. The DEM data were then input 
to MIKE21 model to simulate 2D flood inundation in the study area.  
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iv 

 

สารบัญ 
 
เร่ือง                       หน้า 
บทคดัยอ่ภาษาไทย    i 
บทคดัยอ่ภาษาองักฤษ   ii 
คาํนิยม   iii 
สารบญั   iv 
สารบญัภาพ   vi 
สารบญัตาราง   x 
บทท่ี 1 คาํนาํ วตัถุประสงค ์และขอบเขตการศึกษา   1 
1.1 คาํนาํ        1 
1.2 วตัถุประสงค ์   1 
1.3 ขอบเขตการศึกษา   1 
บทท่ี 2 การตรวจเอกสาร   2 
2.1 งานวจิยัท่ีมีการประยกุตใ์ชแ้บบจาํลอง MIKE21 ท่ีผา่นมา      2 
2.2 หลกัการและทฤษฎีเบ้ืองตน้ของ MIKE21                     4 
2.3 ตวัแปรพื้นฐานของ MIKE21                                           4 
2.4  หลกัการและทฤษฎีเบ้ืองตน้ของ LIDAR        9 
บทท่ี 3 อุปกรณ์และวธีิการ         10 
3.1 อุปกรณ์           10 
3.2 วธีิการ            17 
บทท่ี 4 ผลการศึกษาและวจิารณ์     19 
4.1 ส่วนการสร้างแผนท่ีภูมิประเทศเชิงตวัเลข                                19 
4.2 ส่วนการจาํลองการไหลดว้ยแบบจาํลอง MIKE21      22 
บทท่ี 5 สรุปและขอ้เสนอแนะ         25 
5.1 สรุป   25 
5.2 ขอ้เสนอแนะ  25 
เอกสารอา้งอิง  26 
 
 



v 

 

 
สารบัญ (ต่อ) 

 
เร่ือง  หน้า 
ภาคผนวก   27 
ภาคผนวก ก  28 
- ตารางแสดงขอ้มูลค่าพิกดัและระดบั (*.xyz ) จากการปรับแก,้ 
ขยายมาตราส่วน และแปลงขอ้มูล 
ภาคผนวก ข           32 
- การปรับแกแ้ละแปลงขอ้มูลค่าพิกดัและระดบัความสูง 
ภาคผนวก ค.           35 
- การสร้างแผนภูมิประเทศเชิงตวัเลข (DEM: Digital Elevation Model) 
ภาคผนวก ง  61 
- การดูแผนท่ีภูมิประเทศเชิงตวัเลขแบบ 3 มิติดว้ย Animator ในชุดโปรแกรม MIKE Zero   
ภาคผนวก จ            66 
- ขั้นตอนการจาํลองดว้ย MIKE21 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



vi 

 

สารบัญภาพ 
 
ภาพที ่                     หน้า 
2.1 การกาํหนดช่ือขอบเขตของช่องทางนํ้าเปิด      6 
2.2 การเปล่ียนช่ือขอบเขตของช่องทางนํ้าเปิด      6 
2.3 แสดงการสะทอ้นกลบัของคล่ืนแม่เหล็กไฟฟ้าในหลกัการของ LIDAR   9 
3.1  แบบจาํลองทางกายภาพของภาควชิาวศิวกรรมชลประทาน               10 
3.2 โครงสร้างท่ีใชย้ดึเคร่ืองวดัระยะเลเซอร์                 11 
3.3 ภาพมุมบนแสดงทิศทางบนโครงสร้างท่ีเคร่ืองวดัระยะเลเซอร์เคล่ือนท่ีได้              11 
3.4 เคร่ืองวดัระยะเลเซอร์ LEICA DISTOTM classic5 a                12 
3.5 ภาพการสร้างไฟลแ์ผนท่ีภูมิประเทศเชิงตวัเลขดว้ย Mesh Generator               13 
3.6 หนา้ต่างการสร้างไฟลก์ารจาํลองการไหลโดยใช ้Flow Model FM ใน MIKE21              14 
3.7 ภาพการดูผลการสร้างไฟลแ์ผนท่ีภูมิประเทศเชิงตวัเลขแบบ 3 มิติ ดว้ย Animator             14 
3.8 ตารางการบนัทึกค่าใน โปรแกรม Microsoft office Excel                           15 
3.9 ภาพแสดงขอ้มูลบางส่วนท่ีทาํการแปลงแลว้ดว้ยโปรแกรม Notepad              15 
3.10 เคร่ืองคอมพิวเตอร์ส่วนบุคคล                  16 
4.1 ขอ้มูลดิบของค่าพิกดั และระดบับางส่วนจากโปรแกรม Microsoft Excel              19 
4.2 ขอ้มูลหลงัการปรับแกแ้ละขยายมาตราส่วนของ                 20 
ค่าพิกดั และระดบับางส่วนจากโปรแกรม Notepad 
4.3 ขอ้มูลค่าพิกดัและระดบัท่ีนาํเขา้ และเส้นกาํหนดขอบเขตของช่องทางนํ้าเปิด             21 
4.4 แผนภูมิประเทศเชิงตวัเลขท่ีเปิดดว้ย Animator ในชุดโปรแกรม MIKE Zero                       22 
4.5 การไหลท่ีถูกจาํลองดว้ยแบบจาํลอง MIKE21                 23 
 
 
 
 
 
 
 
 



vii 

 

สารบัญภาพ (ต่อ) 
 
ภาพผนวกที่                         หน้า 
ข 1 ขอ้มูลดิบบางส่วนท่ีอ่านไดจ้ากสเกลในแนว  X และ Y     33 
       และค่าระดบัท่ีอ่านไดจ้ากเคร่ืองวดัระยะเลเซอร์ 
ข 2 ขอ้มูลบางส่วนท่ีปรับแกค้่าระดบัแลว้       33 
ข 3 ภาพแสดงหลกัการปรับแกค้่าระดบัท่ีอ่านไดจ้ากเคร่ืองวดัระยะเลเซอร์   33 
ข 4 ขอ้มูลบางส่วนเปรียบก่อน หลงั การขยายมาตราส่วน     34 
ข 5 ภาพแสดงการแปลงไฟล ์นามสกุล .xls  เป็นไฟลน์ามสกุล .prn    34 
ข 6 ภาพแสดงหนา้ต่างโปรแกรม Notepad จากไฟลน์ามสกุล .prn ไปเป็นไฟลน์ามสกุล xyz 34 
ค 1 การเขา้ใชชุ้ดโปรแกรม MIKE Zero จากเมนู Start ในวนิโดว ์    36 

ค 2 การเร่ิมสร้างไฟลใ์หม่ใน MIKE Zero       36 
ค 3 การคลิกเลือกไอคอน Mesh Generator เพื่อเร่ิมสร้างแผนท่ีภุมิประเทศเชิงตวัเลข  37 
ค 4 การเลือกโซน map projection        37 
ค 5 หนา้ต่างเร่ิมตน้ของ Mesh Generator       38 
ค 6 การนาํเขา้ขอ้มูล ค่าพิกดัและระดบั       38 
ค 7 หนา้ต่างการเพิ่มขอ้มูล ค่าพิกดัและระดบั      39 
ค 8 การเลือกไฟล ์ค่าพิกดัและระดบั เพื่อนาํเขา้      39 
ค 9 การเลือกโซน map projection        40 
ค 10 หนา้ต่างการเพิ่มขอ้มูล ค่าพิกดัและระดบั หลงัการเลิกขอ้มูลแลว้   40 
ค 11 ค่าพิกดัและระดบัท่ีเป็นจุด จากขอ้มูลท่ีนาํเขา้      41 
ค 12 เคร่ืองมือ Insert nodes        41 
ค 13 เคร่ืองมือ Draw arc         41 
ค 14 การใชเ้คร่ืองมือ Insert nodes ลงจุดตามท่ีลูกศรช้ีเพื่อกาํหนดขอบเขต   42 
ค 15 การเช่ือมจุดแต่ละจุดดว้ยเคร่ืองมือ Draw Arc      43 
ค 16 เคร่ืองมือ Select arcs        43 
ค 17 การใชเ้คร่ืองเคร่ืองมือ Select arcs เลือก, กาํหนด ช่องทางนํ้าเปิด   44 
ค 18 การเลือกเปล่ียนลกัษณะของเส้นจากการคลิกขวาเลือก Properties   45 
ค 19 หนา้ต่าง Arc Property        45 
ค 20 การเลือกเปล่ียนลกัษณะของเส้น       46 



viii 

 

สารบัญภาพ (ต่อ) 
 
ภาพผนวกที่                         หน้า 
ค 21 การเลือกเปล่ียนลกัษณะของเส้นท่ีใชเ้ป็นช่องทางนํ้ าเขา้    47 
ค 22 การเลือกเปล่ียนลกัษณะของเส้นท่ีใชเ้ป็นช่องทางนํ้ าเออก    48 
ค 23 การตรวจสอบการกาํหนดค่า Arc Property      49 
ค 24 เคร่ืองมือMove Point        49 
ค 25 การเคร่ืองมือ Move Point แกไ้ขลกัษณะ Boundary     50 
ค 26 การเร่ิมสร้าง DEM โดยเลือกเมนู Mesh และ Generate Mesh    50 
ค 27 หนา้ต่าง Mesh Generation        51 
ค 28 ภาพหลงัการ Generate Mesh        52 
ค 29 การเลือกเมนู Smooth Mesh        53 
ค 30 ภาพหนา้ต่าง Smoothing        53 
ค 31 การเลือกเมนู Interpolate        54 
ค 32 หนา้ต่าง Interpolation        54 
ค 33 การเลือกเมนู Refine Mesh        55 
ค 34 หนา้ต่าง MIKE Zero  หลงัการเลือกเมนู Refine Mesh     55 
ค 35 การเลือกเมนู Analyse Mesh        56 
ค 36 หนา้ต่าง Analyse Mesh        56 
ค 37 Mesh ท่ีทาํเสร็จแลว้         57 
ค 38 การเลือกเมนู Export Mesh        58 
ค 39 การเลือกท่ีบนัทึก Mesh ไฟล ์       58 
ค 40 การตั้งช่ือและบนัทึก Mesh ไฟล ์       59 
ค 41 หนา้ต่าง Export Mesh หลงัจากตั้งและเลือกท่ีบนัทึกไฟลแ์ลว้    59 
ค 42 การเลือกเมนู Save All        60 
ค 43 หนา้ต่าง Save As         60 
ง 1 การเขา้ใชชุ้ดโปรแกรม MIKE Zero จากเมนู Start ในวนิโดว ์    62 
ง 2 การเร่ิมสร้างไฟลใ์หม่ใน MIKE Zero       62 
ง 3 การคลิกเลือกไอคอน Animator เพื่อดูแผนท่ีภุมิประเทศเชิงตวัเลขแบบ 3 มิติ  63 
ง 4 หนา้ต่าง Animator         63 



ix 

 

สารบัญภาพ (ต่อ) 
 
ภาพผนวกที่                         หน้า 
ง 5 การเพิ่มไฟลใ์น Animator        64 
ง 6 การท่ีตอ้งการเพิ่มไฟลใ์น Animator       64 
ง 7 แผนท่ีภูมิประเทศเชิงตวัเลขแบบ 3 มิติ เปิดดว้ย Animator    65 
จ 1 การเขา้ใชชุ้ดโปรแกรม MIKE Zero จากเมนู Start ในวนิโดว ์    67 
จ 2 การเร่ิมสร้างไฟลใ์หม่ใน MIKE Zero       67 
จ 3 การคลิกเลือกไอคอน Flow Model FM  เพื่อเร่ิมทาํการจาํลองแบบจาํลอง   68 
จ 4 หนา้ต่างเร่ิมตน้การทาํงานของแบบจาํลอง MIKE21     68 
จ 5 หนา้ต่าง Domain ก่อนการเพิ่มไฟล ์       69 
จ 6 หนา้ต่าง Open เพื่อการเพิ่มไฟล ์DEM       69 
จ 7 หนา้ต่าง Domain ท่ีทาํการเพิ่มไฟล ์DEM แลว้      70 
จ 8 หนา้ต่าง Domain ในแถบ Domain Specification     70 
จ 9 หนา้ต่าง Time ใน MIKE21 Flow Model FM      71 
จ 10 หนา้ต่าง Eddy Viscosity ใน Hydrodynamic Module     71 
จ 11 หนา้ต่าง Bed Resistance ใน Hydrodynamic Module     72 
จ 12 หนา้ต่าง Coriolis Forcing ใน Hydrodynamic Module     72 
จ 13 หนา้ต่าง Code 2 ใน Boundary Conditions      73 
จ 14 หนา้ต่าง Code 3 ใน Boundary Conditions      74 
จ 15 หนา้ต่าง Outputs         75 
จ 16 หนา้ต่าง Output 1 ในแถบ Output specification     76 
จ 17 หนา้ต่าง Save ก่อนการจาํลองใน MIKE21      77 
จ 18 เมนู Run          77 
จ 19 หนา้ต่าง Launch settings        78 
 
 
 
 
 



x 

 

สารบัญตาราง 
 

ตารางผนวกที่            หน้า 
ก 1 แสดงขอ้มูลค่าพิกดัและระดบั (*.xyz ) จากการปรับแก,้ขยายมาตราส่วน และแปลงขอ้มูล      29 
 
 
 
 
 
 
 
 
 



 1 

บทที ่1 
 

ค าน า วตัถุประสงค์ และขอบเขตการศึกษา 
 

1.1 ค าน า 
 

 ปัจจุบนัลุ่มน ้าประสบกบัปัญหาจากอุทกภยัเน่ืองจากหลายสาเหตุ ยกตวัอยา่งเช่น การเกิดฝน
ตกหนักในลุ่มน ้ า การพิบัติของเข่ือนหรืออาคารชลศาสตร์ขนาดใหญ่ท่ีตั้ งอยู่ด้านเหนือน ้ า และ
ระดบัน ้ าทะเลท่ีสูงข้ึนซ่ึงท าให้น ้ าไม่สามารถระบายออกสู่ทะเลได ้ซ่ึงปัญหาทั้งหมดกระทบกบัชีวิต
ความเป็นอยูข่องประชาชน ไดแ้ก่ บา้นเรือนท่ีอยู่อาศยั พื้นท่ีเกษตรกรรม พื้นท่ีอุตสาหกรรมท่ีตั้งอยู่
บริเวณตอนล่างของลุ่มน ้า ดงันั้นจากสาเหตุดงักล่าวขา้งตน้ จึงตอ้งหาวิถีทางป้องกนัและบรรเทา โดย
การหาสาเหตุ และผลท่ีจะเกิดข้ึน ด้วยการจ าลองแบบสภาพอุทกภัยด้วยโปรแกรมซอฟแวร์
คอมพิวเตอร์ เพื่อใหท้ราบถึงผลท่ีจะเกิดข้ึน โดยโครงงานน้ีจะน าเสนอถึงการน าแบบจ าลอง MIKE21 
มาจ าลองการไหลของน ้ าเขา้ท่วมพื้นท่ี ซ่ึงการจ าลองดงักล่าวสามารถน าไปประยุกตใ์ช้กบัพื้นท่ีจริง
ได ้เช่น เพื่อหาพื้นท่ีเส่ียงภยั และพื้นท่ีอพยพชัว่คราวเม่ือเกิดเข่ือนแตก 

 

1.2 วตัถุประสงค์ 
 

 1. เพื่อศึกษาวธีิการสร้าง แผนท่ีภูมิประเทศเชิงตวัเลข (DEM Digital Elevation Model) 
ใน MIKE Zero 

2. เพื่อศึกษาการจ าลองการไหลของแบบจ าลองทางกายภาพของระบบลุ่มน ้ าของภาควิชา
วศิวกรรมชลประทานดว้ยแบบจ าลอง MIKE21 

 

1.3 ขอบเขตการศึกษา 
 

1. การประยุกต์ใช้แบบจ าลอง MIKE21 เพื่อน าไปจ าลองการไหลของแบบจ าลองทาง
กายภาพของระบบลุ่มน ้าของภาควชิาวศิวกรรมชลประทาน 

2. การส ารวจจดัเก็บขอ้มูล DEM จะใช้การตรวจวดัจากเคร่ืองวดัระยะเลเซอร์ LEICA 
DISTOTM Classic5 A  

3. ค่าระดับน ้ าและปริมาณการไหลเข้าและออกท่ีจะน ามาใช้เป็นข้อมูลด้านเข้าของ
แบบจ าลอง MIKE21 จะใชจ้ากการสมมติข้ึน  
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บทที ่2 
 

การตรวจเอกสาร 
 

 

2.1 งานวจัิยทีม่ีการประยุกต์ใช้แบบจ าลอง MIKE21 ทีผ่่านมา  
Patro et al. (2009) ไดป้ระยกุตใ์ชแ้บบแบบจ าลองอุทกพลศาสตร์ MIKE11 ร่วมกบั MIKE21 

ในการศึกษาดา้นอุทกภยั โดยแบบจ าลองทั้งสองถูกใช้เพื่อจ าลองขอบเขตของน ้ าท่วมและความลึก
ของน ้ าท่วมในปากลุ่มแม่น ้ า Mahanadi ในประเทศอินเดีย โดยเร่ิมจากท าการปรับเทียบแบบจ าลอง 
MIKE 11 โดยใช้ระดบัน ้ าในแม่น ้ าดงักล่าวในช่วงเดือนมรสุม (มิถุนายน ถึง ตุลาคม) ของปี ค.ศ. 
2002 ต่อมาการสอบเทียบกบัค่าระดบัน ้ าในช่วงเวลาเดียวกนัของปี ค.ศ. 2001 ส่วนแบบจ าลอง 
MIKE21 นั้นใชค้่า Bathymetry ของพื้นท่ีศึกษาท่ีมีความละเอียดเชิงพื้นท่ี 90 เมตร ซ่ึงเตรียมจาก 
SRTM DEM เป็นขอ้มูลน าเขา้ หลงัจากนั้น ไดน้ าแบบจ าลองทั้งสองมาเช่ือมโยงกนั เพื่อสร้างแผนท่ี
น ้ าท่วม (flood inundation maps) ในพื้นท่ีศึกษา โดยเลือกใชเ้หตุการณ์อุทกภยัในปี ค.ศ. 2001 มาใช้
สร้างแผนท่ีน ้ าท่วมดังกล่าว และได้น าผลท่ีได้มาเปรียบเทียบกับขอบเขตน ้ าท่วมท่ีเกิดข้ึนจริงท่ี
ประเมินไดจ้ากภาพถ่ายดาวเทียม WiFS IRS - 1D ซ่ึงผลท่ีไดจ้ากแบบจ าลองทั้งสองมีความใกลเ้คียง
กบัสภาพน ้าท่วมท่ีเกิดข้ึนจริง 

 

Sole et al. (2010) กล่าววา่ น ้ าท่วมเป็นหน่ึงในภยัท่ีร้ายแรงสุด และก่อให้เกิดความเสียหาย
เป็นอยา่งมาก ซ่ึงในหลายประเทศก าลงัเผชิญอยู ่นอกจากน้ีการเปล่ียนแปลงสภาพภูมิอากาศ และ เขต
เมืองมีการเจริญเติบโตมากข้ึน ความถ่ี และความรุนแรงของเหตุการณ์น ้ าท่วมน้ีไดเ้พิ่มความสนใจใน
การศึกษาวิจยั ในการศึกษาของ Sole et al. (2010) ไดแ้นะน าเก่ียวกบัการวาดภาพของพื้นท่ีน ้ าท่วมท่ี
เป็นไปได้ในพื้นท่ีภูเขาเพื่อท าเคร่ืองหมายพื้นท่ีน ้ าท่วม โดยเลือกใช้พื้นท่ีศึกษาในประเทศ
สกอตแลนด์ตอนใต้ งานวิจยัน้ีมีวตัถุประสงคเ์พื่อวิเคราะห์ความจุของขอ้มูลเลเซอร์สแกน ส าหรับ
ค าอธิบายลกัษณะชายฝ่ังและแบบจ าลองพื้นท่ีความเส่ียงน ้าท่วม DTM สามารถอธิบายถึงช่องทางและ
ลกัษณะรายละเอียดขอ้มูล Floodplain ท่ีท างานดว้ยเลเซอร์ความละเอียดสูงและขอ้มูลภูมิประเทศ 
ก าหนดกลยุทธ์ท่ีมีประสิทธิภาพสูงสุดส าหรับการวาดภาพของพื้นท่ีน ้ าท่วมโดยใช้การเปรียบเทียบ 
แบบหน่ึงมิติ HEC-RAS พฒันาโดย USACE กบัแบบสองมิติ MIKE 21 HD โดย DHI  
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พรทิพย ์(2552) ไดศึ้กษาโปรแกรม MIKE 21 และการใชง้านในการพยากรณ์การกระจายตวั
ของดชันีคุณภาพน ้ าในทะเลสาบสงขลา ซ่ึงเป็นทะเลสาบขนาดใหญ่ท่ีสุดในประเทศไทยและมีทาง
ติดต่อกบัทะเล ซ่ึงก าลงัประสบปัญหามลพิษทางน ้ า  ลกัษณะ MIKE 21 เป็นแบบจ าลองท่ีเหมาะ
ส าหรับระบบแหล่งน ้ าท่ีมีการไหลของน ้ าเป็นแบบ 2 ทิศทาง ท่ีง่ายและสะดวกต่อการใช้งาน และ
สามารถเปล่ียนแปลงไดต้ามสภาพแวดลอ้มซ่ึงใชไ้ดก้บัพื้นท่ีท่ีเป็น ทะเลสาบ ปากแม่น ้ า ทะเลเปิด 
และพื้นท่ีชายฝ่ัง สามารถจ าลองได ้2 มิติในแนวราบและความแปรผนัในแนวด่ิงมีนอ้ย MIKE 21 มี
ลกัษณะการท างานเป็นโมดูล และมีเมนูควบคุมใชไ้ดท้ั้งแบบโตต้อบกบัผูใ้ช ้(Interactive) และ แบบ
สั่งงานโดยตรง (Batch) สามารถใชศึ้กษาสภาพทางชลศาสตร์ และส่ิงแวดลอ้มตลอดจน ปรากฏการณ์
อ่ืนๆ เช่น การตกตะกอน และ คล่ืนในพื้นท่ีชายฝ่ัง ภายหลงัจากการเปรียบเทียบปรับค่าระดบัน ้ า
ความเร็วและทิศทางกระแสน ้า กบัจุดท่ีมีการวดั ในทะเลสาบ และปรับแกค้่าสัมประสิทธ์ิการกระจาย
ตวัโดยใช้ข้อมูลความเค็ม แล้วจึงน าไปพยากรณ์การกระจายของดัชนีคุณภาพน ้ าท่ีส าคญั คือ 
ออกซิเจนละลายน ้ า (DO) ความตอ้งการออกซิเจนชีวภาพ (BOD) แอมโมเนีย (Ammonia) และ        
ไนเตรท (Nitrate) ในทะเลสาบสงขลาท่ี อาจจะเกิดข้ึนในปี พ.ศ. 2539 2549 และ 2559 พบวา่ คุณภาพ
น ้ าส่วนใหญ่จดัอยู่ในคุณภาพน ้ าผิวดินชั้นท่ี 2-3 ยกเวน้ปากคลองต่างๆ ท่ีเป็นแหล่งรองรับน ้ าเสีย
โดยตรงจากชุมชน และโรงงาน อุตสาหกรรม จากผลการพยากรณ์ดงักล่าวไดน้ าไปสู่การก าหนด
มาตรการในการควบคุมแหล่งก าเนิดมลพิษโดยรอบทะเลสาบสงขลา เช่น การก่อสร้างระบบบ าบดัน ้ า
เสียชุมชน การควบคุมปริมาณน ้าทิ้งจากปศุสัตว ์นากุง้ และกิจกรรมอ่ืนๆ โดยวางคุณภาพน ้ าเป้าหมาย
ในทะเลสาบอยา่งต ่าไวท่ี้คุณภาพน ้ าชั้นท่ี 3 บางส่วน เพื่อให้ทางหน่วยราชการไดน้ าไปใชเ้ป็นกรอบ
ในการจดัการคุณภาพน ้าในลุ่มน ้าทะเลสาบสงขลาต่อไป 
 

วิษุวฒัก์ (2552) ท าการศึกษาเพื่อจ าลองการเปล่ียนแปลงของระดบัน ้ าทะเลบริเวณพื้นท่ี
ชายฝ่ังท่าเรือเมืองดาร์วิน ประเทศออสเตรเลีย โดยประยุกต์ใช้แบบจ าลอง MIKE21 HDFM ซ่ึง
พฒันาข้ึนโดย DHI Water Environment and Health ประเทศเดนมาร์ก เพื่อท าการจ าลองแบบการไหล
แบบ 2 มิติ โดยใช้วิธี Flexible Mesh ในการสร้างขอ้มูลภูมิประเทศใตท้อ้งทะเล (Bathymetry) ซ่ึง
ครอบคลุมพื้นท่ีศึกษาเท่ากบั 450 ตารางกิโลเมตร การปรับเทียบแบบจ าลองเลือกใชช่้วงเวลาระหวา่ง
วนัท่ี 24 ต.ค. 2537 ถึงวนัท่ี 23 พ.ย. 2537 โดยท าการเปรียบเทียบระดบัน ้ าทะเลรายชัว่โมงท่ีค านวณ
ไดก้บัค่าท่ีตรวจวดัจริงบริเวณท่าเรือเมืองดาร์วิน ผลการศึกษาพบว่าแบบจ าลองดงักล่าวให้ผลการ
ค านวณระดบัน ้ าทะเลท่ีมีความถูกตอ้งสูงและมีเสถียรภาพในการค านวณ แบบจ าลองดงักล่าวจะถูก
ใชใ้นการศึกษากระบวนการแพร่กระจายส าหรับประเมินผลดชันีคุณภาพน ้าต่อไป 
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2.2 หลกัการและทฤษฎเีบือ้งต้นของ MIKE21 
MIKE 21 เป็นชุดซอฟตแ์วร์มืออาชีพทางวิศวกรรมท่ีมีการสร้างแบบจ าลองระบบครบวงจร

ส าหรับการไหลสองมิติในทางน ้ าเปิด MIKE 21 ใชไ้ดก้บัปรากฏการณ์จ าลองแบบทางชลศาสตร์ท่ี
เก่ียวขอ้งทั้งในทะเลสาบ ปากแม่น ้ า อ่าว พื้นท่ีชายฝ่ังทะเล ซ่ึง MIKE 21 ไดถู้กออกแบบเฉพาะให้มี
ความยืดหยุน่ในการจ าลองแบบโดยใช้เทคนิคท่ีมีก าหนดมาตรฐานในการจ าลองแบบจ าลอง 2 มิติ 
โดยโปรแกรมออกแบบให้เป็นมิตรผูใ้ช้ ซ่ึงสามารถอ านวยความสะดวกในการโปรแกรมของได้
หลากหลาย และสนบัสนุน ซอฟตแ์วร์เพื่อใชใ้นการจดัเตรียมขอ้มูลการวิเคราะห์ผลการจ าลองและ
น าเสนอกราฟิก MIKE21 เป็นผลจากการพฒันามากกวา่ 20 ปีอยา่งต่อเน่ืองจากการใชง้านมากมายทัว่
โลก  
  
2.3 ตัวแปรพืน้ฐานของ MIKE21 
Domain 
 MIKE 21 Flow Model (FM) กบั ตาข่ายการไหล (Mesh) ท่ีเหมาะสมเป็นส่ิงจ าเป็นส าหรับ
ได้ผลท่ีน่าเช่ือถือได้จากแบบจ าลอง ซ่ึงประกอบด้วยการเลือกพื้นท่ีท่ีเหมาะสมท่ีจะจ าลอง ความ
ละเอียดท่ีเพียงพอของขอบเขต Bathymetry รวมทั้ง คล่ืนลมและการไหลระหวา่งการพิจารณา และค า
นิยามขอบเขตของรหสัส าหรับเปิดและปิด นอกจากความละเอียดในพื้นท่ีทางภูมิศาสตร์จะตอ้งเลือก
ท่ีเก่ียวกบัความมัน่คงพิจารณา ซ่ึง MIKE 21 FM นั้นอยูบ่นพื้นฐานของความยืดหยุน่ของตาข่ายการ
ไหล (Mesh) 
 
Mesh and bathymetry 
 การสร้างไฟล์ตาข่ายการไหล (Mesh) ใน MIKE Zero Mesh Generator ซ่ึงเป็นเคร่ืองมือ
ส าหรับการสร้างตาข่ายการไหลซ่ึงไม่มีโครงสร้างตายตวั รวมถึงขอ้ก าหนด และการแกไ้ขขอบเขต 
 
Map projection 
 ถา้ตาข่ายการไหล (Mesh) สร้างโดย MIKE Zero Mesh Generator การฉายแผนท่ีท่ีมีการ
ก าหนดในไฟล์ตาข่ายการไหล (Mesh) จะปรากฏเฉพาะส าหรับการอา้งอิงในส่วนติดต่อผูใ้ช้หาก 
ขอ้มูลโครงแผนท่ีไม่ไดก้  าหนดไวใ้นไฟล์ตาข่ายการไหล (Mesh) ฉะนั้นจึงตอ้งเลือกโครงแผนท่ีท่ี
ถูกตอ้งสอดคลอ้งกบัขอ้มูลในไฟลต์าข่ายการไหล (Mesh) 
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Minimum depth cutoff 
 ถา้ระดบั Bathymetry ในองคป์ระกอบอยูเ่หนือค่า Cut off ต ่าสุดแลว้ ค่า Cut off จะแทนท่ี ใน 
Bathymetry ค่าจริงในการค านวณ ซ่ึงค่า Cut off อาจจะลบเป็นระดบัตาม Bathymetry ซ่ึงมกัจะแสดง
ใหเ้ห็นใน ไฟลต์าข่ายการไหล (Mesh) 
 
 ถา้การใชร้ะดบัท่ียกตวัข้ึน (Datum Shift)  ค่าความลึก Cut off  จะมีความสัมพนัธ์ท่ีถูกตอ้ง
กบัความลึกเช่นหากมีไฟลต์าข่ายการไหล (Mesh) ท่ีมีค่าระหวา่ง +2 และ -20 เมตร หากเปล่ียนตวัเลข 
เหล่าน้ีเป็นตวัเลขท่ีแตกต่างกบัการเปล่ียนของ +1 เมตร ค่าท่ีถูกตอ้งของ Bathymetry ท่ีตอ้งแกไ้ขคือ
ค่าตอนช่วงระหว่าง +1 และ -21 เมตร คุณสามารถ Cut off ทั้งหมดขา้งตน้ 2 เมตร โดยปล่อยให้
Bathymetry ใชใ้นช่วงระหวา่ง -2 และ -21 เมตร 
 
Datum shift 

ทั้ งน้ีสามารถใช้ตวัเลขระดับเพื่อความสะดวกในการติดตั้งตาข่ายการไหล (Mesh) ของ
แบบจ าลอง ซ่ึงสามารถใชแ้ผนภูมิระดบั, ค่าระดบัดาราศาสตร์ต ่าสุด (LAT) หรือระดบัน ้ าทะเลปาน
กลาง (MSL) ซ่ึงตวัเลขจริงนั้นไม่ส าคญั 
 
 ส่ิงท่ีส าคญัในแต่ละการจ าลอง ควรจะตอ้งให้แต่ละแบบจ าลองมีความถูกตอ้งความสูง ท่ี
ระดบัอา้งอิงแบบจ าลองเทียบกบัตวัเลขท่ีใชใ้นการติดตั้งของ Bathymetry ระดบัยกตวั (Datum Shift) 
ท่ีระบุ ดว้ยวิธีน้ีจะสามารถด าเนินการจ าลองการใชช่้วงระดบัน ้ าท่ีแตกต่างกนัไดโ้ดย ไม่จ  าเป็นตอ้ง
เปล่ียนแปลง ไฟลต์าข่ายการไหล (Mesh) 
 
 
 
 
 
 
 
 
 
 
 



 6 

Boundary names  
 เม่ือสร้างตาข่ายการไหล (Mesh) โดยใช้ MIKE Zero Mesh Generator ควรก าหนดรหัส
ส าหรับช่องทางน ้าเปิดตามรูปดา้นล่าง เพื่อแสดงความหมายของรหสัในโปรแกรมง่าย 
 

   
           ท่ีมา: DHI (2004) 

        ภาพที ่2.1 การก าหนดช่ือขอบเขตของช่องทางน ้าเปิด 
 
 ในกรณีน้ีสามช่องเปิดได้ตรวจพบจากไฟล์ตาข่ายการไหล (Mesh) ท่ีระบุในพารามิเตอร์
โดเมน 2 โคด้ 3 โคด้ 4 โคด้ ในช่ือขอบเขตหลกั สามารถเปล่ียนช่ือรหสัท่ีเหมาะสมกวา่ได ้   ดงัในรูป 
 

   
 
   ภาพที ่2.2 การเปล่ียนช่ือขอบเขตของช่องทางน ้าเปิด 
 
Time 
 ระยะเวลาท่ีจะครอบคลุมการจ าลองจะระบุไวใ้นกล่องโตต้อบน้ี ซ่ึงจะตอ้งระบุวนัเร่ิมตน้การ 
จ าลองสถานการณ์จ านวนรวมของขั้นตอนเวลา และช่วงเวลาโดยรวมขั้นตอน (เป็นวินาที) เวลาไม่
ต่อเน่ืองรวมขั้นตอนท่ีระบุไวใ้นหน้าน้ีใช้เพื่อก าหนดความถ่ีท่ี Output ได้จากโมดูลต่างๆและ
ประสานระหวา่งโมดูลต่างๆ 
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Hydrodynamic Module  
 โมดูลอุทกพลศาสตร์ค านวณการไหลและการกระจายของเกลือ  อุณหภูมิ อาจหลากหลาย
ขอ้บงัคบัและเง่ือนไขขอบเขตของ Baroclinic เน่ืองจากเกลือและการเปล่ียนแปลงอุณหภูมิจะถือว่า
นอ้ยในโมดูล HD และตอ้งท าการตั้งค่าในส่วนน้ี 
 
Solution Technique 
 เวลาการจ าลอง และความถูกตอ้งสามารถควบคุมโดยการระบุ เพื่อแผนการตวัเลขท่ีใช้ใน 
การค านวณตวัเลข ทั้งโครงการส าหรับเวลารวมและ discretization พื้นท่ีท่ีสามารถระบุ ผูใ้ช้งาน
สามารถเลือกแต่ละอนัดบัน้อยๆ  (ล าดบัแรก) หรือการเลือกล าดบัท่ีสูงข้ึนเพื่อความเร็วแต่แม่นย  า
นอ้ยลง ซ่ึงเป็นรายละเอียด เก่ียวกบัเทคนิคการแกปั้ญหาเชิงตวัเลข 
 
 รวมเวลาของสมการการพาและการแพร่กระจาย ( advection-dispersion ) สมการจะ
ด าเนินการโดยใชรู้ปแบบท่ีชดัเจนเน่ืองจากขอ้จ ากดัความมัน่คงโดยใชข้ั้นตอนท่ีชดัเจนในช่วงเวลา 
เพื่อให้จ  านวน CFL นอ้ยกว่า 1 ตวัแปร ขั้นตอนช่วงเวลาท่ีใชใ้นการค านวณของทั้งสมการน ้ าต้ืน 
(Shallow water) และสมการการพา ก าหนดให้จ านวน CFL นอ้ยกวา่จ านวนCFL ส าคญัในโหนดการ
ค านวณทั้งหมด CFL ตวัเลขส าหรับสมการการพา มกัจะไม่จ  ากดักวา่ CFL ตวัเลขส าหรับสมการน ้ า
ต้ืนดงันั้นช่วงเวลาขั้นตอนใหญ่ ปกติจะใชส้ าหรับการพามากกวา่สมการน ้ าต้ืน เพื่อควบคุมขั้นตอน
เวลาท่ียงัเป็นไปไดส้ าหรับผูใ้ชเ้พื่อระบุ ขั้นตอนขั้นตอนระยะเวลา ขั้นต ่าและเวลาสูงสุด ในขั้นตอน
ช่วงเวลาท่ีสมการการพาใช้เวลาและขั้นตอนทั้งหมด ช่วงเวลาส าหรับขั้นตอนของสมการน ้ าต้ืนอยู่
ตรงท่ี ช่วงเวลาส าหรับขั้นตอนในสมการการพา 
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CFL number 
ส าหรับ สมการน ้ าต้ืนในพิกดั Cartesian Courant - Friedrich - Levy (CFL) จ านวนหมายถึง
   

  
โดย 

  h   เป็นความลึกของน ้ารวม 
u  และ v  เป็นองคป์ระกอบความเร็วท่ีมีใน ทิศทาง x และ y 

  g   คือความเร่งโนม้ถ่วง 
Δx และ Δy  เป็นขนาดความยาวลกัษณะในทิศทาง x และ y ในแต่ละ 
  องคป์ระกอบ  
Δt   เป็นขั้นช่วงเวลา ( time step interval) 
 

ขนาดความยาวจ าเพาะ, Δx และ Δy เป็นระยะประมาณการขอบต ่าสุดส าหรับแต่ละ
องคป์ระกอบและความลึกน ้ า และองคป์ระกอบความเร็วท่ีประเมินจากศูนยก์ลาง ส าหรับสมการการ
พาในพิกดั Cartesian CFL ถูกก าหนดเป็นสมการดงัน้ี 
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2.4  หลกัการ และทฤษฎเีบือ้งต้นของ LIDAR 
 LIDAR ยอ่มาจากค าวา่ Light Detection And Ranging ซ่ึงเป็นการท าแผนท่ีโดยใชเ้ลเซอร์ท่ี
ติดไวก้บัอากาศยานส ารวจพื้นผิว เพื่อระบุสถานท่ีตั้ง และขอ้มูลระดบัความสูง ของพื้นดินหรือวตัถุ 
โดยติดตั้งอยู่ท่ีใตเ้ฮลิคอปเตอร์ หรือเคร่ืองบินปีกถาวร ซ่ึงระบบ LIDAR จะใช้ส่วนใกลอิ้นฟราเรด
ของคล่ืนแสงแม่เหล็กไฟฟ้า (1064 nm) โดยมีความสามารถในการเก็บรวบรวมขอ้มูลได้ในทั้ง
กลางวนัและกลางคืนหรือในเงาและใตเ้มฆได ้ ซ่ึงค่าท่ีไดจ้ะน ามาประมวลผลรวมกบัค่าระดบัความ
สูงของเคร่ืองบินและค่าพิกดัต าแหน่ง สุดทา้ยจะไดเ้ป็นขอ้มูลค่าพิกดัและความสูง (.xyz)  ซ่ึงสามารถ
น าไปสร้างเป็นแผนท่ีภูมิประเทศเชิงตวัเลขได ้
 
 

 
 

ภาพที ่2.3 แสดงการสะทอ้นกลบัของคล่ืนแม่เหล็กไฟฟ้าในหลกัการของ LIDAR 
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บทที ่3 
 

อุปกรณ์และวธีิการ 
 

3.1 อุปกรณ์ 
 
 

1. แบบจ าลองทางกายภาพของระบบลุ่มน ้าของภาควชิาวศิวกรรมชลประทาน 
    เน่ืองจากความสนใจในแบบจ าลองทางกายภาพของภาควิชาวิศวกรรมชลประทาน ในการ
จ าลองจึงน าค่าระดบัท่ีเก็บไดจ้ากแบบจ าลองทางกายภาพดงักล่าวมาท าการแปลงให้เป็น 
แผนท่ีภูมิประเทศเชิงตวัเลข (DEM Digital Elevation Model) เพื่อเป็นขอ้มูลน าเขา้สู่
แบบจ าลอง MIKE21 

 
 

 
 

 

ภาพที ่3.1  แบบจ าลองทางกายภาพของภาควชิาวศิวกรรมชลประทาน 
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2. วสัดุท่ีน ามาใชเ้ป็นโครงยดึเคร่ืองวดัระยะเลเซอร์ 
    จากแบบจ าลองทางกายภาพในขอ้ก่อนหนา้ เพื่อใหเ้คร่ืองวดัระยะเลเซอร์มีระดบัอา้งอิงใน
แนวระนาบท่ีคงท่ี จึงจดัท าโครงสร้างข้ึนดงัภาพท่ี 3.2 เพื่อใชย้ดึเคร่ืองวดัระยะเลเซอร์ ซ่ึง
ออกแบบใหส้ามารถเคล่ือนท่ีไดใ้นแนวแกน X และ Y ตามภาพท่ี 3.3 

 

 
 

ภาพที ่3.2 โครงสร้างท่ีใชย้ดึเคร่ืองวดัระยะเลเซอร์ 
 

         
 

ภาพที ่3.3 ภาพมุมบนแสดงทิศทางบนโครงสร้างท่ีเคร่ืองวดัระยะเลเซอร์เคล่ือนท่ีได้

Y 

X 

แบบจ าลองทาง
กายภาพ 



 12 

3. เคร่ืองวดัระยะเลเซอร์ LEICA DISTOTM classic5 a 
  จากหลกัการของ ระบบส ารวจรังวดัระดบัความสูงภูมิประเทศดว้ยแสงเลเซอร์ท่ีติดตั้งบน

อากาศยาน ( LIDAR Light Detection and Ranging) จึงไดน้ ามาประยกุตใ์ชก้บัเคร่ืองวดัระยะ
เลเซอร์ในภาพ 3.4 โดยค่าท่ีไดจ้ะเป็นค่าระดบัของแบบจ าลองทางกายภาพ หรือค่า  Z ซ่ึง
จะตอ้งท าการปรับแกก่้อนดงัแสดงใน  ภาคผนวก ข.การปรับแกแ้ละแปลงขอ้มูลค่าพิกดัและ
ระดบัความสูง 

 
 

                          
 

        ภาพที ่3.4 เคร่ืองวดัระยะเลเซอร์ LEICA DISTOTM classic5 a 
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              4. ชุดโปรแกรม MIKE Zero จาก DHI version 2009 

จากชุดโปรแกรม MIKE Zero จาก DHI version 2009 ในโครงงานจะใชง้านอยู ่3 ส่วนคือ  
ส่วนท่ี 1 การสร้างไฟลแ์ผนท่ีภูมิประเทศเชิงตวัเลขโดยใช ้Mesh Generator ตามภาพ 3.5 
ส่วนท่ี 2 การสร้างไฟล์การจ าลองโดยใช ้ Flow Model FM ใน MIKE21 ซ่ึงมีหนา้ต่างการ 

ท างานดงัแสดงในภาพท่ี  3.6 
ส่วนท่ี 3 การดูแผนท่ีภูมิประเทศเชิงตวัเลข หรือผลการจ าลอง แบบ 3 มิติ ดว้ย Animator 
 ดงัตวัอยา่งในภาพ 3.7 
 

    
 

         ภาพที ่3.5 ภาพการสร้างไฟลแ์ผนท่ีภูมิประเทศเชิงตวัเลขดว้ย Mesh Generator 
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           ภาพที ่3.6 หนา้ต่างการสร้างไฟลก์ารจ าลองการไหลโดยใช ้Flow Model FM ใน MIKE21 
 

             
 
           ภาพที ่3.7 ภาพการดูผลการสร้างไฟลแ์ผนท่ีภูมิประเทศเชิงตวัเลขแบบ 3 มิติ ดว้ย Animator 
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 5. โปรแกรม Microsoft office Excel version 2003 หรือ 2007 
มีส่วนส าคัญในการเก็บข้อมูล เพื่อความสะดวกในแปลงค่าภายหลัง จึงจัดเก็บด้วย 

Microsoft office Excel ซ่ึงมีลกัษณะเป็นตารางตามภาพท่ี 3.8 โดยมีความง่ายต่อการบนัทึก
ขอ้มูล แปลงขอ้มูล หรือการปรับแกข้อ้มูลจ านวนมาก 

 

 
 

            ภาพที ่3.8 ตารางการบนัทึกค่าใน โปรแกรม Microsoft office Excel 
  
 6. โปรแกรม Notepad 

     มีส่วนส าคัญด้านข้อมูลเช่นกันแต่จะเน้นไปในด้านการแปลงข้อมูล จากโปรแกรม 
Microsoft office Excel ก่อนน าเขา้สู่การสร้างไฟล์แผนท่ีภูมิประเทศเชิงตวัเลขใน Mesh 
Generator โดยตวัโปรแกรมมีลกัษณะตามภาพท่ี 3.9 
  

            
 

 

                   ภาพที ่3.9 ภาพแสดงขอ้มูลบางส่วนท่ีท าการแปลงแลว้ดว้ยโปรแกรม Notepad 
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 7. เคร่ืองคอมพิวเตอร์ส่วนบุคคล 
มีส่วนส าคญัอยา่งยิง่ในการท าโครงงาน ซ่ึงเคร่ืองคอมพิวเตอร์ท่ีใชย้ิง่มีความสามารถใน

การประมวลผลสูงเท่าใดยิง่ท  าใหก้ารท างานมีความรวดเร็วมากข้ึน โดยจะเห็นไดช้ดัเม่ือท า
การจ าลองการไหล ซ่ึงหากเคร่ืองคอมพิวเตอร์ท่ีใชมี้ความสามารถในการประมวลผลต ่าก็จะ
ส่งผลท าใหใ้ชเ้วลาในการจ าลองแบบจ าลองนานไปดว้ย 

   

                               
 

                       ภาพที ่3.10 เคร่ืองคอมพิวเตอร์ส่วนบุคคล 
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3.2 วธีิการ 
 
 

1.ท าการวดัขนาดของแบบจ าลองทางกายภาพ 
   เพื่อน าค่าท่ีไดไ้ปใชอ้อกแบบโครงสร้างท่ีใชย้ดึเคร่ืองวดัระยะเลเซอร์ 
  
2.ท าการออกแบบและประกอบเหล็กเป็นโครงสร้างท่ีใชย้ดึติดกบัเคร่ืองวดัระยะเลเซอร์ 
เม่ือได้ค่าความกวา้งยาวของแบบจ าลองทางกายภาพแล้ว จึงน าค่าท่ีได้มาใช้ออกแบบ
โครงสร้างและทิศทางการเคล่ือนท่ีของเคร่ืองวดัระยะเลเซอร์ 
 

3.น าโครงเหล็กท่ีไดม้าประกอบยดึติดกบัแบบจ าลองทางกายภาพ 
เม่ือท าการตัดช้ินส่วนของโครงสร้างตามท่ีได้ออกแบบแล้ว จึงท าการติดตั้ งเข้ากับ
แบบจ าลองทางกายภาพ 

 
4.ท าการปรับตั้งค่าระดบัของโครงเหล็กใหไ้ดร้ะนาบ 
หลงัจากติดตั้งโครงสร้างเขา้กบัแบบจ าลองทางกายภาพจะท าการปรับตั้งค่าระดบัของ  
โครงสร้างเพื่อลดความคลาดเคล่ือนของระดบัท่ีวดัได ้

 
5.เร่ิมท าการเก็บขอ้มูล 
 เก็บขอ้มูลโดยแบ่งเป็น 3 แกน X,Y,Z โดยจดัเก็บใน Microsoft Excel ซ่ึงค่าแกน X,Y 

สามารถอ่านไดจ้ากสเกลท่ีท าไวก้บัโครงสร้างท่ีใชย้ึดเคร่ืองอ่าน ส่วนค่า Z สามารถอ่าน
ไดจ้ากเคร่ืองวดัระยะเลเซอร์ 

 
6.น าขอ้มูลท่ีไดม้าค านวณและแปลงเขา้สู่แบบจ าลอง MIKE21 
ก่อนน าเขา้ขอ้มูลสู่แบบจ าลอง MIKE21 จะตอ้งแปลงขอ้มูลท่ีไดจ้าก Microsoft Excel เป็น
ไฟล์ .prnใน Microsoft Excel แลว้จึงแปลงต่อให้เป็นไฟล์ .xyz ใน โปรแกรม Notepad 
ก่อนท่ีจะน าเขา้ไปใชใ้นการสร้างแผนท่ีภูมิประเทศเชิงตวัเลข 
 

7.ท าการสร้างแผนท่ีภูมิประเทศเชิงตวัเลข 
ท าการสร้างแผนท่ีภูมิประเทศเชิงตวัเลขโดยใช ้Mesh Generator ในชุดโปรแกรม MIKE 
Zero 
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8.น าแผนท่ีภูมิประเทศเชิงตวัเลขท่ีสร้างแลว้มาเขา้สู่แบบจ าลอง MIKE21 
 
9.ท าการสุ่มค่าอตัราการไหลใหก้บัแบบจ าลอง 
เน่ืองจากแบบจ าลองทางกายภาพไม่สามารถวดัอตัราการไหลได ้ดงันั้นจึงใช้การสุ่มค่า
อตัราการไหลเขา้ไปแทน 
 

10.เร่ิมท าการจ าลองแบบจ าลอง 
   เม่ือท าการสมมติค่าต่างๆ ในแบบจ าลองเสร็จแลว้ จึงเร่ิมท าการจ าลอง 
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บทที ่4 
 

ผลการศึกษาและวจิารณ์ 
 จากวตัถุประสงคข์องโครงงานจะสามารถแบ่งผลการศึกษาและวจิารณ์ออกเป็น 2 ส่วนดงัน้ี 
4.1 ส่วนการสร้างแผนทีภู่มิประเทศเชิงตัวเลข 

ผลการศึกษา  
จากการศึกษาจะพบวา่มีส่วนส าคญั 2 ส่วน คือ 

4.1.1 ส่วนของขอ้มูลน าเขา้  
 จากการเก็บขอ้มูลดว้ยเคร่ืองวดัระยะเลเซอร์จะไดผ้ลเป็นขอ้มูลดิบ ซ่ึงค่าระดบั (ค่า Z ) จะอยู่
ในรูปของทศนิยม 3 ต าแหน่งในหน่วยเมตร ดงัภาพท่ี 4.1  
 

       
   
  ภาพที ่4.1 ขอ้มูลดิบของค่าพิกดั และระดบับางส่วนจากโปรแกรม Microsoft Excel 
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 โดยเม่ือท าการปรับแกค้่าค่าระดบัในโปรแกรม Microsoft Excel และขยายมาตราส่วนเพื่อลด
ปัญหาการปัดเศษทศนิยมแลว้ จะตอ้งท าการแปลงขอ้มูลดว้ยโปรแกรม Notepad ซ่ึงสุดทา้ยจะได้
ผลลพัธ์ของขอ้มูลเป็นไฟล์นามสกุล (.xyz) ดงัแสดงในภาพท่ี 4.2 หรือสามารถดูขอ้มูลค่าระดบัและ
พิกดัหลงัการปรับแกแ้ละขยายมาตราส่วนทั้งหมดไดใ้น ภาคผนวก ก.ตารางแสดงขอ้มูลค่าพิกดัและ
ระดบั (*.xyz ) จากการปรับแก,้ขยายมาตราส่วน และแปลงขอ้มูล 
 

         
  
          ภาพที ่4.2 ขอ้มูลหลงัการปรับแกแ้ละขยายมาตราส่วนของ 

                           ค่าพิกดั และระดบับางส่วนจากโปรแกรม Notepad 
 

4.1.2 ส่วนของการน าขอ้มูลมาสร้างเป็นแผนท่ีภูมิประเทศเชิงตวัเลข 
 จากผลของขอ้มูลค่าพิกดัและระดบั (.xyz) หลงัการปรับแก ้ขยายมาตราส่วน และการแปลง
ขอ้มูลแลว้ ขอ้มูลดงักล่าวจะน ามาเป็นขอ้มูลส่วนน าเขา้ ในการสร้างแผนท่ีภูมิประเทศเชิงตวัเลข ซ่ึง
ภาพหลงัการน าเขา้ขอ้มูลค่าพิกดัและระดบั และท าการก าหนดขอบเขตของช่องทางน ้ าเปิด แลว้จะได้
เป็นดงัภาพท่ี 4.3 โดยการน าเขา้ขอ้มูลค่าพิกดัและระดบั และการก าหนดขอบเขตของช่องทางน ้าเปิด 
จะแสดงรายละเอียดขั้นตอนการท าในภาคผนวก ค.การสร้างแผนภูมิประเทศเชิงตวัเลข ( DEM 
Digital Elevation Model ) 
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         ภาพที ่4.3 ขอ้มูลค่าพิกดัและระดบัท่ีน าเขา้ และเส้นก าหนดขอบเขตของช่องทางน ้าเปิด 
 

โดยเม่ือท าการน าเขา้ขอ้มูลค่าพิกดัและระดบั และเส้นก าหนดขอบเขตของช่องทางน ้ าเปิด
ตามกระบวนการดงัแสดงในรายละเอียด ภาคผนวก ค.การสร้างแผนภูมิประเทศเชิงตวัเลข ( DEM 
Digital Elevation Model ) และท าตามกระบวนการจนเสร็จ จะท าให้ไดผ้ลลพัธ์เป็น แผนภูมิประเทศ
เชิงตวัเลขดงัแสดงในภาพท่ี 4.4 ซ่ึงจะน าไปใชใ้นขั้นตอนการจ าลองดว้ยแบบจ าลอง MIKE21 ต่อไป 
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        ภาพที ่4.4 แผนภูมิประเทศเชิงตวัเลขท่ีเปิดดว้ย Animator ในชุดโปรแกรม MIKE Zero 
 
วจิารณ์  
จากการเก็บขอ้มูลจนถึงการสร้างแผนท่ีภูมิประเทศเชิงตวัเลข ส่วนท่ีมีความส าคญัมากใน

ขั้นตอนน้ีน่าจะเป็นการปรับแกข้อ้มูลเพราะเน่ืองจากขอ้มูลท่ีอ่านไดจ้ากเคร่ืองวดัระยะเลเซอร์นั้นเป็น
ขอ้มูลระยะระหวา่งเคร่ืองวดัระยะเลเซอร์กบัแบบจ าลองหากการปรับแกผ้ิดพลาดอาจท าให้พื้นท่ี ท่ี
ควรเป็นร่องน ้ากลบัเป็นสันเขาได ้หรือพื้นท่ี ท่ีควรเป็นเนินเขาอาจกลายเป็นแอ่งน ้าก็เป็นได ้ 

โดยหากเปรียบเทียบกบัหลกัการ LIDAR แลว้ การประยกุตใ์ชเ้คร่ืองวดัระยะเลเซอร์ซ่ึงติดไว้
กบัโครงสร้างท่ีสามารถเคล่ือนท่ีไดใ้นแนวระนาบ ท าให้เกิดผลลพัธ์เป็นแผนท่ีภูมิประเทศเชิงตวัเลข 
( DEM Digital Elevation Model ) ซ่ึงเหมือนกนักบัผลลพัธ์ของวธีิ LIDAR 
  
4.2 ส่วนการจ าลองการไหลด้วยแบบจ าลอง MIKE21 
 ผลการศึกษา 
 จากผลการศึกษา จะไดผ้ลการจ าลองการไหลดงัภาพ 4.5 ซ่ึงมีการก าหนดค่าตวัแปรและ
เง่ือนไขดงัน้ี  
 Minimum depth cutoff = 84.26 
 No. of time steps = 100000 
 Time step interval = 30 sec 
 Simulation start date = 1/1/2004 (d/m/yyyy) 
 Simulation end date = 4/2/2004 (d/m/yyyy) 
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 Boundary Conditions 
 Code2 ; Type = Specified level 
  Format = Constant 
  Constant value = 86 m 
 Code2 ; Type = Specified discharge 
  Format = Constant 
  Constant value = 500 cms 
 Land boundary ; Type = Land (zero normal velocity) 

Initial Conditions 
  Type = Constant 
  Surface elevation = 85 m 
 Output format = Area series 
 
 จากการทดลองสุ่มใชค้่าตวัแปรต่างๆ หลายค่า จะพบวา่ค่าของตวัแปรดงัแสดงดา้นบนจะท า
ใหแ้บบจ าลอง MIKE21 สามารถท าการจ าลองการไหลไดด้งัภาพท่ี 4.5 ซ่ึงเป็นผลการจ าลอง ใน time 
steps = 5727 หรือผลจากการจ าลองไปแลว้เป็นเวลา 47.725 ชัว่โมง 
 

     
 
         ภาพที ่4.5 การไหลท่ีถูกจ าลองดว้ยแบบจ าลอง MIKE21 
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วจิารณ์ 
ดงัท่ีเห็นในภาพท่ี 4.5   การจ าลองการไหลแสดงในลกัษณะเหมือนน ้าท่วมพื้นท่ีอยู ่    ซ่ึงอาจ 

เป็นผลจากปัจจยัหลายดา้นทั้งการสมมติค่าตวัแปรต่างๆ หรือการก าหนดขอบเขตช่องทางการไหล 
(Boundary) ท่ีท าใหแ้บบจ าลอง MIKE21 ไม่สามารถท าการจ าลองการไหลไดอ้ยา่งถูกตอ้งตามสภาพ
ท่ีควรเกิดข้ึนจริงนัน่เอง
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             บทที ่5 
 

สรุปและข้อเสนอแนะ 
 

5.1 สรุป 
จากการศึกษาท่ีไดพ้บว่า แบบจ าลองไม่สามารถค านวณให้ไดผ้ลเฉลยท่ีเหมาะสมได ้มีการ 

Convergence ออกไปในทุกๆ ค่าอตัราการไหลและระดบัน ้ าท่ีทดลองสุ่ม ดงัแสดงในภาพดา้นล่าง 
จากปัญหาท่ีเกิดข้ึนท าใหส้รุปไดว้า่ การจดัท าแบบจ าลองน้ีจ าเป็นจะตอ้งใชข้อ้มูลท่ีตรวจวดัไดจ้ริงใน
แม่น ้ามาใชใ้นการจ าลอง เน่ืองจากค่าอตัราการไหลท่ีสมมติข้ึนนั้นหากการสมมติมีความคลาดเคล่ือน
จากความเป็นจริงมากก็จะท าให้แบบจ าลองไม่สามารถจ าลองการไหลได ้ฉะนั้นในการจ าลองการ
ไหลจึงควรใชค้่าท่ีตรวจวดัไดจ้ริงเพื่อการจ าลองท่ีง่ายข้ึน 

แต่อยา่งไรก็ตามจากการศึกษาแบบจ าลองนั้นท าใหไ้ด ้ แผนท่ีภูมิประเทศเชิงตวัเลข (DEM 
Digital Elevation Model) ซ่ึงเป็นแผนท่ีพื้นผวิ 3 มิติ ท่ีสร้างข้ึนจากการน าค่าพิกดัและระดบัมาท าการ
ประมวลผลและสร้างข้ึนมาเป็นพื้นผวิ  

 
5.2 ข้อเสนอแนะ 
 จากการศึกษาจะพบวา่ค่าอตัราการไหลจ าเป็นตอ้งสมมติข้ึน เน่ืองจากไม่สามารถวดัไดจ้าก
แบบจ าลองทางกายภายโดยตรง ฉะนั้นแบบจ าลองน้ีจึงควรมีค่าอตัราการไหลท่ีเป็นขอ้มูลจริงท่ีได้
จากการตรวจวดัมาท าการจ าลองเพื่อท าให้แบบจ าลองสามารถจ าลองการไหลได้ และเพื่อความ
น่าเช่ือถือในการจ าลองจึงควรใช้แบบจ าลองอ่ืนๆ ท่ีสามารถจ าลองการไหลได้มาท าการจ าลอง
เปรียบเทียบกนั 
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ภาคผนวก ก 
ตารางแสดงข้อมูลค่าพกิดัและระดับ (*.xyz ) 

จากการปรับแก้,ขยายมาตราส่วน และแปลงข้อมูล 
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ตารางผนวกที ่ก 1 แสดงขอ้มูลค่าพิกดัและระดบั (*.xyz ) จากการปรับแก,้ขยายมาตราส่วน และ
แปลงขอ้มูล 

 
x y z 

 
x y z 

 
x y z 

 
x y z 

 
x y z 

100 0 74 
 

2220 0 65 
 

1300 100 52 
 

540 200 79 
 

1470 325 94 

200 0 73 
 

2250 0 70 
 

1390 100 57 
 

550 200 74 
 

1600 325 92 

300 0 76 
 

2300 0 87 
 

1450 100 64 
 

580 200 77 
 

1700 325 91 

400 0 77 
 

2400 0 85 
 

1500 100 71 
 

610 200 66 
 

1800 325 90 

410 0 77 
 

100 100 75 
 

1600 100 71 
 

680 200 72 
 

1900 325 91 

430 0 70 
 

200 100 74 
 

1700 100 76 
 

710 200 77 
 

2000 325 87 

460 0 54 
 

300 100 69 
 

1800 100 75 
 

790 200 76 
 

2110 325 83 

500 0 50 
 

350 100 76 
 

1900 100 70 
 

810 200 86 
 

2220 325 80 

600 0 51 
 

410 100 74 
 

2000 100 64 
 

830 200 82 
 

2300 325 81 

700 0 49 
 

430 100 73 
 

2100 100 71 
 

910 200 80 
 

2390 325 85 

800 0 52 
 

450 100 77 
 

2180 100 86 
 

920 200 83 
 

200 425 81 

900 0 52 
 

470 100 53 
 

2240 100 85 
 

1000 200 87 
 

100 425 79 

1000 0 51 
 

490 100 52 
 

2320 100 84 
 

1100 200 88 
 

250 425 70 

1100 0 48 
 

520 100 53 
 

2390 100 83 
 

1200 200 88 
 

300 425 71 

1200 0 47 
 

540 100 67 
 

100 200 76 
 

1260 200 89 
 

350 425 68 

1300 0 49 
 

550 100 73 
 

190 200 76 
 

1290 200 75 
 

380 425 63 

1400 0 51 
 

600 100 78 
 

260 200 75 
 

1320 200 60 
 

400 425 72 

1500 0 47 
 

700 100 80 
 

320 200 68 
 

1350 200 61 
 

435 425 86 

1600 0 47 
 

800 100 80 
 

370 200 66 
 

1380 200 75 
 

470 425 85 

1700 0 47 
 

900 100 82 
 

400 200 55 
 

1420 200 90 
 

550 425 87 

1800 0 51 
 

1050 100 82 
 

440 200 56 
 

1500 200 88 
 

700 425 80 

1900 0 52 
 

1100 100 76 
 

490 200 77 
 

1540 200 89 
 

850 425 74 

2000 0 55 
 

1200 100 78 
 

520 200 80 
 

1555 200 79 
 

950 425 82 

2100 0 57 
 

1230 100 68 
 

600 200 82 
 

1635 200 81 
 

1050 425 81 

2200 0 63 
 

1260 100 76 
 

700 200 84 
 

1640 200 85 
 

1130 425 79 

1670 200 86 
 

1100 300 83 
 

240 400 55 
 

2100 400 83 
 

1640 520 67 

1700 200 73 
 

1200 300 91 
 

270 400 57 
 

2200 400 80 
 

1665 520 66 

1800 200 74 
 

1260 300 92 
 

340 400 63 
 

2300 400 81 
 

1690 520 78 

1820 200 88 
 

1280 300 83 
 

410 400 85 
 

2400 400 88 
 

1700 520 81 

1870 200 88 
 

1310 300 63 
 

500 400 85 
 

100 325 78 
 

1710 520 82 

2040 200 81 
 

1320 300 61 
 

600 400 84 
 

140 325 78 
 

1900 520 78 

2150 200 83 
 

1340 300 66 
 

700 400 78 
 

160 325 73 
 

2100 520 76 

2265 200 85 
 

1360 300 78 
 

790 400 73 
 

180 325 55 
 

2350 520 87 

2350 200 82 
 

1385 300 94 
 

900 400 76 
 

200 325 55 
 

200 550 79 

2390 200 82 
 

1450 300 93 
 

1010 400 86 
 

220 325 73 
 

310 550 82 

100 300 77 
 

1500 300 92 
 

1120 400 78 
 

235 325 79 
 

340 550 78 

150 300 72 
 

1600 300 91 
 

1200 400 79 
 

280 325 80 
 

385 550 65 

170 300 65 
 

1700 300 90 
 

1260 400 84 
 

400 325 82 
 

360 550 71 

190 300 52 
 

1800 300 90 
 

1285 400 79 
 

520 325 82 
 

410 550 81 

210 300 54 
 

1900 300 90 
 

1310 400 64 
 

750 325 84 
 

425 550 87 

230 300 69 
 

2000 300 87 
 

1340 400 64 
 

930 325 82 
 

435 550 85 

260 300 79 
 

2100 300 83 
 

1370 400 78 
 

1000 325 89 
 

480 550 70 

300 300 79 
 

2220 300 80 
 

1410 400 95 
 

1100 325 82 
 

530 550 88 

400 300 81 
 

2300 300 82 
 

1450 400 98 
 

1200 325 86 
 

550 550 88 

500 300 81 
 

2360 300 84 
 

1500 400 97 
 

1260 325 87 
 

650 550 88 

650 300 83 
 

2400 300 86 
 

1600 400 98 
 

1280 325 78 
 

950 550 76 

700 300 83 
 

100 400 79 
 

1700 400 91 
 

1310 325 61 
 

1200 550 97 

800 300 85 
 

160 400 80 
 

1840 400 86 
 

1330 325 63 
 

1350 550 87 

900 300 84 
 

170 400 80 
 

1900 400 84 
 

1350 325 77 
 

1500 550 91 

1000 300 88 
 

200 400 67 
 

2000 400 82 
 

1380 325 95 
 

1610 550 93 
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ตารางผนวกที ่ก 1 แสดงขอ้มูลค่าพิกดัและระดบั (*.xyz ) จากการปรับแก,้ขยายมาตราส่วน และ
แปลงขอ้มูล (ต่อ) 

 
x y z 

 
x y z 

 
x y z 

 
x y z 

 
x y z 

1750 650 81 
 

1250 425 84 
 

1450 450 76 
 

1450 500 79 
 

1770 1200 88 

1730 650 74 
 

1280 425 84 
 

1500 450 74 
 

1550 500 86 
 

1700 1200 87 

100 580 77 
 

1300 425 76 
 

1550 450 72 
 

1580 500 84 
 

1630 1200 73 

220 580 80 
 

1320 425 68 
 

1600 450 76 
 

1620 500 67 
 

1560 1200 91 

270 580 81 
 

1340 425 64 
 

1650 450 88 
 

1640 500 66 
 

1420 1200 92 

300 580 76 
 

1365 425 66 
 

1700 450 86 
 

1660 500 70 
 

1390 1200 95 

330 580 67 
 

1370 425 67 
 

1800 450 81 
 

1680 500 79 
 

1370 1200 82 

355 580 63 
 

1400 425 80 
 

490 450 87 
 

1710 500 83 
 

1345 1200 95 

390 580 82 
 

1440 425 90 
 

445 450 86 
 

1760 500 82 
 

1310 1200 95 

370 580 71 
 

1500 425 92 
 

430 450 77 
 

250 520 82 
 

1260 1200 83 

410 580 90 
 

1600 425 90 
 

410 450 64 
 

340 520 83 
 

1190 1200 79 

490 580 86 
 

1690 425 87 
 

380 450 73 
 

370 520 79 
 

1140 1200 87 

520 580 78 
 

1900 425 82 
 

360 450 78 
 

390 520 67 
 

1080 1200 92 

530 580 73 
 

2050 425 79 
 

320 450 83 
 

405 520 64 
 

1020 1200 71 

545 580 71 
 

2200 425 78 
 

210 450 82 
 

420 520 72 
 

950 1200 92 

590 580 87 
 

2300 425 82 
 

140 450 80 
 

435 520 82 
 

850 1200 90 

610 580 91 
 

2400 425 89 
 

100 450 79 
 

450 520 87 
 

750 1200 87 

950 580 78 
 

1250 450 90 
 

450 500 87 
 

480 520 88 
 

700 1200 88 

1170 580 97 
 

1200 450 83 
 

430 500 78 
 

570 520 89 
 

650 1200 89 

1360 580 87 
 

1280 450 87 
 

410 500 64 
 

880 520 75 
 

630 1200 73 

1550 580 96 
 

1295 450 87 
 

390 500 73 
 

1170 520 96 
 

605 1200 89 

1650 580 86 
 

1320 450 80 
 

370 500 82 
 

1300 520 90 
 

470 1200 89 

1615 580 94 
 

1350 450 68 
 

320 500 83 
 

1450 520 88 
 

385 1200 88 

1670 580 73 
 

1380 450 66 
 

1330 500 90 
 

1550 520 90 
 

330 1200 89 

1680 580 66 
 

1410 450 68 
 

1380 500 87 
 

1600 520 85 
 

290 1200 64 

2170 750 86 
 

1640 550 83 
 

1720 640 69 
 

460 225 81 
 

230 1200 86 

2390 800 84 
 

1660 550 68 
 

1740 640 78 
 

370 225 54 
 

150 1200 87 

2170 800 89 
 

1680 550 65 
 

1810 640 82 
 

300 400 59 
 

100 1200 89 

2130 800 68 
 

1700 550 73 
 

2000 640 78 
 

320 400 61 
 

100 1300 110 

2010 800 81 
 

1720 550 79 
 

2100 640 79 
 

80 375 80 
 

500 1300 108 

1990 800 97 
 

1760 550 82 
 

2200 640 78 
 

150 375 78 
 

770 1300 90 

1840 800 90 
 

1900 550 77 
 

2300 640 80 
 

180 375 66 
 

930 1300 91 

1700 800 85 
 

2000 550 77 
 

2350 640 80 
 

200 375 54 
 

975 1300 72 

1640 800 64 
 

2350 550 83 
 

2390 640 84 
 

220 375 56 
 

995 1300 72 

1600 800 68 
 

610 640 90 
 

100 250 79 
 

250 375 64 
 

1040 1300 91 

1550 800 70 
 

620 640 88 
 

170 250 74 
 

290 375 74 
 

1340 1300 95 

1500 800 68 
 

640 640 78 
 

200 250 64 
 

270 375 70 
 

1910 1300 90 

1450 800 71 
 

670 640 74 
 

230 250 54 
 

350 375 82 
 

2300 1300 79 

1400 800 85 
 

710 640 90 
 

240 250 54 
 

400 375 87 
 

1040 1500 86 

1350 800 97 
 

720 640 91 
 

270 250 53 
 

550 375 85 
 

1060 1500 78 

1300 800 97 
 

770 640 93 
 

360 250 65 
 

640 650 80 
 

1080 1500 74 

1235 800 77 
 

1000 640 81 
 

410 250 85 
 

650 650 83 
 

1100 1500 78 

1100 800 99 
 

1190 640 95 
 

480 250 82 
 

660 650 80 
 

1130 1500 91 

1030 800 97 
 

1370 640 87 
 

100 225 77 
 

680 650 76 
 

880 1500 89 

980 800 79 
 

1500 640 96 
 

180 225 76 
 

700 650 76 
 

800 1500 108 

930 800 83 
 

1600 640 94 
 

240 225 64 
 

730 650 91 
 

650 1500 117 

905 800 95 
 

1660 640 85 
 

300 225 55 
 

740 650 92 
 

350 1500 113 

820 800 96 
 

1670 640 80 
 

340 225 54 
 

900 650 90 
 

50 1500 113 

660 800 95 
 

1690 640 64 
 

390 225 56 
 

1650 650 90 
 

1150 1500 92 

635 800 82 
 

1700 640 64 
 

420 225 71 
 

1700 650 64 
 

1550 1500 91 
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ตารางผนวกที ่ก 1 แสดงขอ้มูลค่าพิกดัและระดบั (*.xyz ) จากการปรับแก,้ขยายมาตราส่วน และ
แปลงขอ้มูล (ต่อ) 

 
x y z 

 
x y z 

 
x y z 

 
x y z 

 
x y z 

1085 1100 72 
 

1700 580 66 
 

670 620 89 
 

1700 700 63 
 

2200 1500 74 

1150 1100 97 
 

1710 580 71 
 

755 620 92 
 

1740 700 78 
 

1050 1550 89 

1200 1100 96 
 

1730 580 81 
 

150 650 78 
 

1800 700 82 
 

1095 1550 71 

1265 1100 97 
 

1760 580 83 
 

200 650 79 
 

2100 700 84 
 

1145 1550 90 

1335 1100 79 
 

2100 580 72 
 

220 650 72 
 

2390 700 85 
 

1050 1650 71 

1410 1100 94 
 

1650 620 89 
 

250 650 64 
 

140 750 79 
 

1070 1650 74 

1600 1100 88 
 

1670 620 80 
 

280 650 75 
 

190 750 79 
 

1110 1650 90 

1700 1100 85 
 

1700 620 65 
 

325 650 84 
 

240 750 62 
 

1015 1650 88 

1800 1100 87 
 

1730 620 79 
 

440 650 86 
 

300 750 85 
 

100 1800 110 

1930 1100 89 
 

1900 620 80 
 

520 650 80 
 

430 750 87 
 

500 1800 123 

2015 1100 92 
 

150 620 78 
 

560 650 89 
 

610 750 91 
 

770 1800 118 

2080 1100 91 
 

220 620 79 
 

100 700 77 
 

645 750 80 
 

830 1800 110 

2115 1100 75 
 

250 620 69 
 

190 700 78 
 

660 750 93 
 

900 1800 85 

2145 1100 95 
 

290 620 61 
 

230 700 61 
 

810 750 94 
 

940 1800 73 

2200 1100 93 
 

330 620 76 
 

270 700 81 
 

860 750 76 
 

980 1800 82 

2350 1100 86 
 

320 620 72 
 

610 700 91 
 

925 750 94 
 

1100 1800 107 

2250 1100 89 
 

370 620 84 
 

645 700 78 
 

1100 750 92 
 

1300 1800 114 

2350 1200 81 
 

350 620 82 
 

655 700 90 
 

1330 750 71 
 

1690 1800 113 

2300 1200 80 
 

430 620 85 
 

700 700 91 
 

1440 750 84 
 

2050 1800 90 

2200 1200 83 
 

500 620 80 
 

745 700 75 
 

1560 750 96 
 

2350 1800 88 

2145 1200 90 
 

550 620 89 
 

800 700 93 
 

1620 750 87 
 

2350 2000 110 

2115 1200 74 
 

570 620 90 
 

1000 700 83 
 

1680 750 63 
 

780 2050 123 

2080 1200 89 
 

600 620 86 
 

1330 700 87 
 

1730 750 83 
 

740 2050 96 

1970 1200 86 
 

630 620 73 
 

1550 700 96 
 

1850 750 84 
 

730 2050 94 

1850 1200 87 
 

650 620 80 
 

1650 700 87 
 

2000 750 94 
 

710 2050 98 

680 2050 121 
 

610 800 95 
 

1550 900 98 
 

460 1000 78 
 

2200 2600 280 

500 2050 122 
 

540 800 91 
 

1700 900 98 
 

420 1000 96 
 

1650 2600 289 

1100 2050 123 
 

440 800 87 
 

1995 900 100 
 

335 1000 89 
 

1150 2600 353 

1900 2050 106 
 

325 800 86 
 

2080 900 75 
 

365 1000 91 
 

1050 2600 195 

2400 2250 222 
 

280 800 63 
 

2120 900 75 
 

290 1000 64 
 

1000 2600 112 

2050 2250 167 
 

220 800 78 
 

2150 900 93 
 

245 1000 91 
 

980 2600 110 

1980 2250 119 
 

150 800 80 
 

2300 900 90 
 

200 1000 92 
 

950 2600 90 

1500 2250 122 
 

150 900 83 
 

2300 1000 99 
 

100 1000 91 
 

930 2600 87 

900 2250 118 
 

240 900 82 
 

2145 1000 101 
 

140 1100 88 
 

910 2600 89 

850 2250 96 
 

280 900 65 
 

2110 1000 77 
 

190 1100 88 
 

880 2600 109 

830 2250 94 
 

305 900 73 
 

2080 1000 91 
 

250 1100 87 
 

850 2600 113 

810 2250 96 
 

340 900 90 
 

1800 1000 93 
 

305 1100 62 
 

700 2600 251 

780 2250 113 
 

445 900 94 
 

1600 1000 94 
 

350 1100 90 
 

50 2600 263 

450 2250 114 
 

540 900 96 
 

1400 1000 100 
 

450 1100 89 
 

400 2730 277 

100 2250 110 
 

610 900 98 
 

1135 1000 97 
 

565 1100 91 
 

750 2730 277 

500 2400 149 
 

630 900 86 
 

1070 1000 73 
 

610 1100 74 
 

850 2730 171 

770 2400 121 
 

650 900 99 
 

1010 1000 98 
 

635 1100 77 
 

1150 2730 204 

830 2400 112 
 

820 900 98 
 

940 1000 97 
 

650 1100 90 
 

1800 2730 311 

860 2400 96 
 

870 900 99 
 

885 1000 96 
 

715 1100 91 
 

2220 2730 351 

890 2400 90 
 

890 900 86 
 

865 1000 88 
 

800 1100 93 
    

920 2400 111 
 

920 900 98 
 

845 1000 96 
 

825 1100 84 
    

1000 2400 121 
 

1030 900 98 
 

655 1000 95 
 

845 1100 93 
    

1700 2400 144 
 

1120 900 74 
 

635 1000 83 
 

905 1100 91 
    

2150 2400 218 
 

1190 900 96 
 

620 1000 94 
 

980 1100 87 
    

2400 2400 260 
 

1300 900 98 
 

495 1000 93 
 

1030 1100 94 
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       ภาคผนวก ข 
   การปรับแก้และแปลงข้อมูลค่าพกิดั 

   และระดับความสูง 
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การปรับแก้และแปลงข้อมูลค่าพกิดัและระดับความสูง 
 

ขอ้มูลโดยแบ่งเป็น 3 แกน x,y,z โดยจดัเก็บใน Microsoft Excel ตามภาพดา้นล่าง ซ่ึงค่า
แกน x,y สามารถอ่านไดจ้ากสเกลท่ีท าไวก้บัโครงสร้างท่ีใชย้ดึเคร่ืองอ่าน ส่วนค่า z สามารถอ่านได้
จากเคร่ืองวดัระยะเลเซอร์ 

 

    
 

                ภาพผนวกที ่ข 1 ขอ้มูลดิบบางส่วนท่ีอ่านไดจ้ากสเกลในแนว  X และ Y  
   และค่าระดบัท่ีอ่านไดจ้ากเคร่ืองวดัระยะเลเซอร์ 
 

จากค่าระดบัความสูง (z) ท่ีไดจ้ะเป็นค่าระยะระหว่างปลายเคร่ืองวดัระยะเลเซอร์ถึงระดบั
ของแบบจ าลองทางกายภาพ จึงต้องท าการปรับแก้ค่าเสียก่อนโดยก าหนดระยะสูงสุดของ
แบบจ าลองทางกายภาพ ในท่ีน้ีก าหนด 0.9 เมตร และน าค่าระดบัความสูง (z) มาหกัลบออกก็จะท า
ให้ได้ค่าระดบัความสูงท่ีถูกตอ้งตามหลกัการในภาพผนวกท่ี ข 3 หลงัจาการปรับแกจ้ะไดค้่าท่ี
เปล่ียนไปดงัภาพผนวกท่ี ข 2 

         
      
       ภาพผนวกที ่ข 2 ขอ้มูลบางส่วนท่ีปรับแกค้่าระดบัแลว้ 
 
 
   
 
    
 
    ภาพผนวกที ่ข 3 ภาพแสดงหลกัการปรับแกค้่าระดบัท่ีอ่านไดจ้ากเคร่ืองวดัระยะเลเซอร์ 

ค่า z  ท่ีอ่านไดจ้ากเคร่ือง 0.9
 

ค่า z ท่ีถูกตอ้ง 

เคร่ืองวดัระยะ 



 34 

โดยก่อนการแปลงไดท้  าการขยายมาตราส่วนของแบบจ าลองโดยท าการคูณดว้ย 1000 
เพื่อใหม้าตราส่วนค่อนขา้งใกลเ้คียงกบัของจริงและเพื่อลดปัญหาเก่ียวกบัการปัดเศษทศนิยม ซ่ึงจะ
ไดค้่าใหม่ดงัภาพดา้นล่าง 

 

     
  
              ภาพผนวกที ่ข 4 ขอ้มูลบางส่วนเปรียบก่อน หลงั การขยายมาตราส่วน 
 

เร่ิมท าการแปลงไฟลจ์ากไฟล ์ Microsoft Excel (*.xls) เป็นไฟล ์ Formatted Text (Space 
delimited) (*.prn) โดยใชเ้ฉพาะค่าตวัเลขไม่ตอ้งน าหวัตารางมาดว้ยดงัภาพซา้ยแลว้จึงท าการแปลง
ไฟล ์โดยการบนัทึกเป็น เป็นแบบ Formatted Text (Space delimited) (*.prn) ดงัภาพดา้นล่าง 

  

          
 
      ภาพผนวกที ่ข 5 ภาพแสดงการแปลงไฟล ์นามสกุล .xls  เป็นไฟลน์ามสกุล .prn 

 
น าไฟลท่ี์ไดม้าเปิดในโปรแกรม Notepad แลว้ท าการเซฟใหม่โดยพิมพช่ื์อไฟลแ์ลว้ต่อดว้ย 

*.xyz ก็จะไดไ้ฟลพ์ิกดัและความสูง ท่ีจะน าไปใชส้ร้างแผนท่ีภูมิประเทศเชิงตวัเลข ตามภาพ
ดา้นล่าง 

   
 
                        ภาพผนวกที ่ข 6 ภาพแสดงหนา้ต่างโปรแกรม Notepad  

 จากไฟลน์ามสกุล .prn ไปเป็นไฟลน์ามสกุล xyz  
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                 ภาคผนวก ค 

        การสร้างแผนภูมิประเทศเชิงตัวเลข  
         ( DEM Digital Elevation Model ) 
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การสร้างแผนภูมิประเทศเชิงตัวเลข (DEM: Digital Elevation Model) 
จากขอ้มูลค่าพิกดัและระดบัความสูง เร่ิมท าการสร้างแผนภูมิประเทศเชิงตวัเลขโดย Mesh 

generator ชุดโปรแกรม MIKE Zero ตามขั้นตอนดงัภาพ 
  
 1.เรียกโปรแกรม MIKE Zero จาก Start Menu 
   

     
 

      ภาพผนวกที ่ค 1 การเขา้ใชชุ้ดโปรแกรม MIKE Zero จากเมนู Start ในวนิโดว ์
 

 2.ท าการเลือกสร้างไฟลใ์หม่ 
  

   
 
             ภาพผนวกที ่ค 2 การเร่ิมสร้างไฟลใ์หม่ใน MIKE Zero 



 37 

 3.เลือก โฟลเดอร์ MIKE Zero และเลือกไฟล ์Mesh Generator (.mdf ) 
                            

 
 

   ภาพผนวกที ่ค 3 การคลิกเลือกไอคอน Mesh Generator เพื่อเร่ิมสร้างแผนท่ีภุมิประเทศเชิงตวัเลข 
 

โดยเม่ือไฟล ์Mesh Generator แลว้จะปรากฏหนา้ต่าง Workspace projection ใหเ้ลือกเป็น 
WGS_1984_UTM_Zone_47N  

  

 
 
         ภาพผนวกที ่ค 4 การเลือกโซน map projection 
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  เสร็จแลว้จะปรากฏหนา้ต่างการท างานดงัภาพดา้นล่าง 
 

   
 
         ภาพผนวกที ่ค 5 หนา้ต่างเร่ิมตน้ของ Mesh Generator 
 

4.ท าการน าเขา้ขอ้มูลค่าพิกดัและความสูง โดยเลือกเมนู Data > Import Scatter Data…    ดงัภาพ
ดา้นล่าง 

 
 

     
 
             ภาพผนวกที ่ค 6 การน าเขา้ขอ้มูล ค่าพิกดัและระดบั 
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เสร็จแลว้จะปรากฏหนา้ต่าง Import Scatter Data ดงัภาพ และท าการคลิกท่ีปุ่ม Add เพื่อ
เลือกเพิ่มขอ้มูล 

 

    
  
                    ภาพผนวกที ่ค 7 หนา้ต่างการเพิ่มขอ้มูล ค่าพิกดัและระดบั 

 
หลงัจากคลิกปุ่ม Add จะปรากฏหนา้ต่างใหเ้ลือกไฟล ์.xyz ท่ีไดท้  าไวก่้อนหนา้ในหวัขอ้
การปรับแกแ้ละแปลงขอ้มูลค่าพิกดัและระดบัความสูง เม่ือเลือกแลว้คลิกปุ่ม Open 

 

    
 
    ภาพผนวกที ่ค 8 การเลือกไฟล ์ค่าพิกดัและระดบั เพื่อน าเขา้ 
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จากนั้นจะปรากฏหนา้ต่าง Map Projection ใหเ้ลือก WGS_1984_UTM_Zone_47N  
แลว้คลิกปุ่ม OK เพื่อตกลง 
   

    
 

     ภาพผนวกที ่ค 9 การเลือกโซน map projection 
 

เสร็จแลว้จะกลบัมาในหนา้ต่าง Import Scatter Data โดยมีไฟล ์.xyz เพิ่มเขา้มาในบรรทดั
แรกดงัภาพแลว้คลิกปุ่ม Apply และคลิกปุ่ม Close ดงัภาพดา้นล่าง 
 

  
     

                        ภาพผนวกที ่ค 10 หนา้ต่างการเพิ่มขอ้มูล ค่าพิกดัและระดบั หลงัการเลิกขอ้มูลแลว้ 
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  จากนั้นโปรแกรมจะสร้างจุดพิกดัข้ึนมาดงัภาพ 
 

   
  
         ภาพผนวกที ่ค 11 ค่าพิกดัและระดบัท่ีเป็นจุด จากขอ้มูลท่ีน าเขา้ 
 

5.ท าการสร้าง Boundary เพื่อสร้างขอบเขตการจ าลองใหแ้บบจ าลอง โดยใชเ้คร่ืองมือ Insert Node 
และ Draw Arc 

 

   
    
           ภาพผนวกที ่ค 12 เคร่ืองมือ Insert nodes    
 

   
 
             ภาพผนวกที ่ค 13 เคร่ืองมือ Draw arc 
 

พิกดัท่ีสร้างข้ึน 
จากไฟล ์(.xyz) 
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ท าการใชเ้คร่ืองมือ Insert nodes ลงจุดต าแหน่งภายในจุดพิกดัจากไฟล ์ .xyz ท่ีสร้างไวต้าม
พื้นท่ี ท่ีตอ้งการท าการจ าลอง โดยจะก าหนดใหน้ ้าไหลเขา้และออก และเช่ือมจุดนั้นดว้ย
เคร่ืองมือ Draw Arc เพื่อแยกเส้นขอบเขตแต่ละส่วนเพื่อก าหนดลกัษณะภายหลงั 
  

 
 

 
            ภาพผนวกที ่ค 14 การใชเ้คร่ืองมือ Insert nodes ลงจุดตามท่ีลูกศรช้ีเพื่อก าหนดขอบเขต 
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        ภาพผนวกที ่ค 15 การเช่ือมจุดแต่ละจุดดว้ยเคร่ืองมือ Draw Arc 

 
ต่อมาท าการก าหนดคุณลกัษณะของเส้นแต่ละเส้นโดยใชเ้คร่ืองมือ Select arcs ในการเลือก
เส้นแต่ละเส้น 
  

  
 

          ภาพผนวกที ่ค 16 เคร่ืองมือ Select arcs 
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เลือกเส้นแต่ละเส้นโดยเวน้ช่องท่ีก าหนดให้น ้าไหลเขา้และออก โดยกดปุ่ม Ctrl และคลิก
เส้นโดยเหลือช่องท่ีก าหนดใหน้ ้าเขา้และออกดงัภาพ 
 

  
  
          ภาพผนวกที ่ค 17 การใชเ้คร่ืองเคร่ืองมือ Select arcs เลือก, ก าหนด ช่องทางน ้าเปิด 
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คลิกขวาท่ีเส้นท่ีท าการเลือกจะปรากฏแถบเมนู ใหค้ลิกท่ีค าวา่ Properties 
 

    
 

       ภาพผนวกที ่ค 18 การเลือกเปล่ียนลกัษณะของเส้นจากการคลิกขวาเลือก Properties 
 
เสร็จแลว้จะปรากฏหนา้ต่าง Arc Property ข้ึนมา ใหค้่าในคอลมัน์ Arc attribute ใหเ้ป็นค่า
ตวัเลขเดียวกนัทั้งหมดในท่ีน้ีก าหนดใหเ้ป็นเลข 1 
 

  
 

      ภาพผนวกที ่ค 19 หนา้ต่าง Arc Property 
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ต่อมาคลิกเลือกเส้นดงัภาพดา้นล่างโดยใชเ้คร่ืองมือ Select arcs แต่เปล่ียนค่าตวัเลขในทั้ง 3 
คอลมัน์ ใหเ้ป็นเลข 1 
 

  
 

        ภาพผนวกที ่ค 20 การเลือกเปล่ียนลกัษณะของเส้น 
 
คลิกเลือกเส้นท่ีก าหนดให้เป็นทางน ้าเขา้ดงัภาพ แลว้ก าหนดค่าใน Arc Property ในทั้ง 3 
คอลมัน์ในเป็น เลข 2 
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  ภาพผนวกที ่ค 21 การเลือกเปล่ียนลกัษณะของเส้นท่ีใชเ้ป็นช่องทางน ้าเขา้ 
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คลิกเลือกเส้นท่ีก าหนดให้เป็นทางน ้าออกดงัภาพ แลว้ก าหนดค่าใน Arc Property ในทั้ง 3 
คอลมัน์ในเป็น เลข 3 
 

 
 
            ภาพผนวกที ่ค 22 การเลือกเปล่ียนลกัษณะของเส้นท่ีใชเ้ป็นช่องทางน ้าเออก 
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ส่วนเส้นท่ีเหลือโปรแกรมจะท าการก าหนดให้จากการท่ี เราท าการป้อนค่า Arc 
Property ใหเ้ส้นอ่ืนไปแลว้โดยสามารถตรวจสอบวา่แต่ละเส้นถูกก าหนดค่า Arc Property 
แลว้หรือไม่ โดยท าการคลิกเลือกทุกเส้นและคลิกขวาเลือก Properties จะเห็นไดว้า่แต่ละ
เส้นถูกก าหนดค่าแลว้หรือไม่ ดงัภาพดา้นล่าง 
  

 
 

                                           ภาพผนวกที ่ค 23 การตรวจสอบการก าหนดค่า Arc Property 
 
และเน่ืองจากโปรแกรมแกรมมีขีดจ ากดัดา้นลิขสิทธ์ิ การจ าลองดว้ย Node ท่ีสร้างข้ึนมีมาก
เกินไปจะท าใหแ้บบจ าลองไม่สามารถจ าลองการไหลได ้ จึงตอ้งขยบัขนาดใหพ้ื้นท่ีท่ีจะท า
การสร้าง Mesh มีขนาดพื้นท่ีเล็กลงดว้ยการยา้ยจุดดว้ยเคร่ืองมือ Move points โดยเม่ือขยบั
จุดแลว้จะไดข้นาดพื้นท่ีท่ีจะสร้าง Mesh ท่ีเล็กลง 
  

  
 

    ภาพผนวกที ่ค 24 เคร่ืองมือMove Point 
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      ภาพผนวกที ่ค 25 การเคร่ืองมือ Move Point แกไ้ขลกัษณะ Boundary 
 

6.ท าการสร้าง Mesh โดยคลิกเมนู Mesh > Generate Mesh… 
   

                 
 

            ภาพผนวกที ่ค 26 การเร่ิมสร้าง DEM โดยเลือกเมนู Mesh และ Generate Mesh… 
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จากนั้นจะข้ึนหนา้ต่าง Mesh Generation ข้ึนมาใหเ้ปล่ียนค่าในช่องแรกเป็น 700 และช่องท่ี 
3 เป็น 5000 ดงัภาพ 
                                   

 
 

        ภาพผนวกที ่ค 27 หนา้ต่าง Mesh Generation 
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 จะท าใหไ้ดเ้ป็นตาข่ายท่ีมีลกัษณะเป็นสามเหล่ียมดงัภาพ 
   

 
 

    ภาพผนวกที ่ค 28 ภาพหลงัการ Generate Mesh 
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 จากนั้นท าการ Smooth Mesh โดยเลือกแถมเมนู Mesh > Smooth Mesh… ดงัภาพ 
 

    
 
            ภาพผนวกที ่ค 29 การเลือกเมนู Smooth Mesh 

   
  เม่ือคลิกค าวา่ Smooth Mesh… จะปรากฏหนา้ต่าง Smoothing ข้ึนมาดงัภาพใหค้ลิกปุ่ม OK 
     

     
 
     ภาพผนวกที ่ค 30 ภาพหนา้ต่าง Smoothing 
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  จากนั้นเลือกเมนู Mesh > Interpolate… ดงัภาพ 
 

      
 
                        ภาพผนวกที ่ค 31 การเลือกเมนู Interpolate 
 
  เม่ือคลิกค าวา่ Interpolate… จะปรากฏหนา้ต่าง Interpolation ข้ึนมาดงัภาพ 

ใหค้ลิกเลือกปุ่ม Start 
 

     
 
            ภาพผนวกที ่ค 32 หนา้ต่าง Interpolation   
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  จากนั้นเลือกเมนู Mesh > Refine Mesh… 
   

          
 
                ภาพผนวกที ่ค 33 การเลือกเมนู Refine Mesh 
 

เม่ือคลิกค าวา่ Refine Mesh… จะปรากฏหนา้ต่าง MIKE Zero  ข้ึนมาดงัภาพ 
ใหค้ลิกเลือกปุ่ม OK 
 

  
 

      ภาพผนวกที ่ค 34 หนา้ต่าง MIKE Zero  หลงัการเลือกเมนู Refine Mesh 
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จากนั้นเลือกเมนู Mesh > Analyse Mesh… 
 

                  
 

ภาพผนวกที ่ค 35 การเลือกเมนู Analyse Mesh 
 
เม่ือคลิกค าวา่ Analyse Mesh…จะปรากฏหนา้ต่าง Analyse Mesh  ข้ึนมาดงัภาพ 
ใหค้ลิกเลือกปุ่ม OK 
 

  
 

           ภาพผนวกที ่ค 36 หนา้ต่าง Analyse Mesh 
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เม่ือเสร็จแลว้จะไดล้กัษณะของ Mesh ดงัภาพ 
 

 
 
           ภาพผนวกที ่ค 37 Mesh ท่ีท าเสร็จแลว้ 
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ท าการ Export ไฟล ์Mesh ท่ีท าเสร็จแลว้ตามกระบวนการดงัภาพดา้นล่าง 
 
เลือกเมนู Mesh > Export Mesh… 
 

  
 

     ภาพผนวกที ่ค 38 การเลือกเมนู Export Mesh 
 
เม่ือคลิกค าวา่ Export Mesh…จะปรากฏหนา้ต่าง Export Mesh ข้ึนมาดงัภาพ 
ใหค้ลิกเลือกปุ่ม … ดงัภาพ เพื่อเลือกท่ีบนัทึก 
 
 

 
 

  ภาพผนวกที ่ค 39 การเลือกท่ีบนัทึก Mesh ไฟล ์
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ท าการเลือกท่ีบนัทึกและตั้งช่ือไฟลแ์ลว้กดปุ่ม Save เพื่อบนัทึก 
 

 
 

        ภาพผนวกที ่ค 40 การตั้งช่ือและบนัทึก Mesh ไฟล ์
 

จากนั้นจะปรากหนา้ต่าง Export Mesh ใหค้ลิกปุ่ม OK 
 

 
 
           ภาพผนวกที ่ค 41 หนา้ต่าง Export Mesh หลงัจากตั้งและเลือกท่ีบนัทึกไฟลแ์ลว้ 
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เสร็จแลว้ท าการ Save All ตามกระบวนการดงัภาพ 
 
เลือกเมนู File > Save All 
  

                  
 

              ภาพผนวกที ่ค 42 การเลือกเมนู Save All 
 

เม่ือคลิกค าวา่ Save All จะปรากฏหนา้ต่าง Save As ข้ึนมาดงัภาพ 
ใหค้ลิกเลือกท่ีบนัทึกและตั้งช่ือไฟล ์แลว้กดปุ่ม Save เพื่อเลือกท่ีบนัทึก 
 

 
 
                              ภาพผนวกที ่ค 43 หนา้ต่าง Save As 
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   ภาคผนวก ง 

การดูแผนทีภู่มิประเทศเชิงตัวเลขแบบ 3 มิติ 
ด้วย Animator ในชุดโปรแกรม MIKE Zero 
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การดูแผนทีภู่มิประเทศเชิงตัวเลขแบบ 3 มิติด้วย Animator ในชุดโปรแกรม MIKE Zero 
   
 1.เรียกโปรแกรม MIKE Zero จาก Start Menu 
   

 
 

     ภาพผนวกที ่ง 1 การเขา้ใชชุ้ดโปรแกรม MIKE Zero จากเมนู Start ในวนิโดว ์
 

 2.ท าการเลือกสร้างไฟลใ์หม่ 
  

   
 
    ภาพผนวกที ่ง 2 การเร่ิมสร้างไฟลใ์หม่ใน MIKE Zero 
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3.เลือก โฟลเดอร์ MIKE Zero และเลือกไฟล ์Animator (.mza) 

 

 
 

                     ภาพผนวกที ่ง 3 การคลิกเลือกไอคอน Animator เพื่อดูแผนท่ีภุมิประเทศเชิงตวัเลขแบบ 3 มิติ 
 
เม่ือคลิก OK จะปรากฏหนา้ต่างดงัภาพ 
 

 
 

  ภาพผนวกที ่ง 4 หนา้ต่าง Animator 
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เลือกเมนู Tools > Add Files to Project…  
 

      
 
              ภาพผนวกที ่ง 5 การเพิ่มไฟลใ์น Animator 
 

เม่ือคลิกค าวา่ Add Files to Project… จะปรากฏหนา้ต่าง Open ข้ึนมาดงัภาพใหค้ลิกเลือก 
File of Type ใหเ้ป็น FM Mesh Files (*.mesh) แลว้เลือกไฟล ์และกดปุ่ม Open  เพื่อเปิดไฟล ์

 

      
 
 ภาพผนวกที ่ง 6 การท่ีตอ้งการเพิ่มไฟลใ์น Animator 
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เสร็จแลว้จะไดเ้ป็นหนา้ต่างท่ีมีแผนท่ีภูมิประเทศเชิงตวัเลขแบบ 3 มิติ 
 

 
 

ภาพผนวกที ่ง 7 แผนท่ีภูมิประเทศเชิงตวัเลขแบบ 3 มิติ เปิดดว้ย Animator 
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            ภาคผนวก จ 
           ขั้นตอนการจ าลองด้วย MIKE21 
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1.เรียกโปรแกรม MIKE Zero จาก Start Menu 
   

 
 

     ภาพผนวกที ่จ 1 การเขา้ใชชุ้ดโปรแกรม MIKE Zero จากเมนู Start ในวนิโดว ์
 

 2.ท าการเลือกสร้างไฟลใ์หม่ 
  

   
 
    ภาพผนวกที ่จ 2 การเร่ิมสร้างไฟลใ์หม่ใน MIKE Zero 
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3.เลือก โฟลเดอร์ MIKE21และเลือกไฟล ์Flow Model FM (.m21fm) 

 

               
 
  ภาพผนวกที ่จ 3 การคลิกเลือกไอคอน Flow Model FM  เพื่อเร่ิมท าการจ าลองแบบจ าลอง 

 
 4.เม่ือคลิกปุ่ม OK จะปรากฏหนา้ต่าง MIKE21 ดงัภาพดา้นล่าง 

   

 
 

    ภาพผนวกที ่จ 4 หนา้ต่างเร่ิมตน้การท างานของแบบจ าลอง MIKE21 
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5.การเพิ่ม Meshไฟลห์รือ DEM เขา้ไปในโดเมน 
 โดยคลิกท่ีแถบโดเมนจะปรากฏหนา้ต่าง Domain ตามภาพผนวกท่ี จ 5 แลว้คลิกท่ีปุ่ม (...) 
เพื่อเพิ่มไฟล ์  
 

      
 
                                  ภาพผนวกที ่จ 5 หนา้ต่าง Domain ก่อนการเพิ่มไฟล์ 
 

  จากนั้นจะปรากฏหนา้ต่าง Open ใหท้  าการเลือกไฟล ์DEM แลว้คลิกปุ่ม Open 
 

 
 
      ภาพผนวกที ่จ 6 หนา้ต่าง Open เพื่อการเพิ่มไฟล ์DEM 
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  เสร็จแลว้ไฟล ์DEM ดงักล่าวจะถูกเพิ่มในโดเมนดงัภาพดา้นล่าง 
 

 
 
        ภาพผนวกที ่จ 7 หนา้ต่าง Domain ท่ีท าการเพิ่มไฟล ์DEM แลว้ 

   
  ต่อมาคลิกเลือกแถบ Domain Specification ในหนา้ต่าง Domain เพื่อก าหนด Minimum
 depth cutoff และ Datum shift ดงัภาพดา้นล่าง  
    

                   
 
ภาพผนวกที ่จ 8 หนา้ต่าง Domain ในแถบ Domain Specification 
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 6.การก าหนด Time step และ Time step interval 
 

     
 

    ภาพผนวกที ่จ 9 หนา้ต่าง Time ใน MIKE21 Flow Model FM 
 
  การก าหนดค่าพารามิเตอร์ของ Eddy Viscosity ใหเ้ป็น No eddy ดงัภาพดา้นล่าง 
 

     
 
                     ภาพผนวกที ่จ 10 หนา้ต่าง Eddy Viscosity ใน Hydrodynamic Module 
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  การก าหนดค่าพารามิเตอร์ของ Bed Resistance ใหเ้ป็น No bed resistance ดงัภาพดา้นล่าง 
 

    
 

           ภาพผนวกที ่จ 11 หนา้ต่าง Bed Resistance ใน Hydrodynamic Module 
 

การก าหนดค่าพารามิเตอร์ของ Coriolis Forcing ใหเ้ป็น No coriolis force ดงัภาพดา้นล่าง 
 

 
 

             ภาพผนวกที ่จ 12 หนา้ต่าง Coriolis Forcing ใน Hydrodynamic Module 
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การก าหนดเง่ือนไขของขอบเขตการไหล โดย Code 2 ก าหนด Type ใหเ้ป็น Specificed 
level ดงัภาพดา้นล่าง 

 

 
 

       ภาพผนวกที ่จ 13 หนา้ต่าง Code 2 ใน Boundary Conditions 
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การก าหนดเง่ือนไขของขอบเขตการไหล โดย Code 3 ก าหนด Type ใหเ้ป็น Specificed 
level ดงัภาพดา้นล่าง 
 

 
 

     ภาพผนวกที ่จ 14 หนา้ต่าง Code 3 ใน Boundary Conditions 
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การเพิ่ม Outputs เพื่อเป็นขอ้มูลไวใ้ชภ้ายหลงั โดยการคลิกแถบ Outputs เสร็จแลว้จะ
ปรากฏหนา้ต่าง Outputs และท าการเพิ่มโดยคลิกปุ่ม New output ดงัภาพดา้นล่าง 
 

         
 

                      ภาพผนวกที ่จ 15 หนา้ต่าง Outputs 
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ต่อมาท าการคลิก Output 1 ในแถบ Outputs และคลิกเลือกแถบ Output 
specification ในหนา้ต่าง Output 1 เพื่อตั้งช่ือไฟลท่ี์จะบนัทึกผลการจ าลอง โดยพิมพช่ื์อ
ไฟลใ์นช่อง Output file 

 

 
 
            ภาพผนวกที ่จ 16 หนา้ต่าง Output 1 ในแถบ Output specification 
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สุดทา้ยก่อนการจ าลองจะตอ้งท าการบนัทึก โดยเลือก เมนู File แลว้คลิกท่ีแถบ 
Save จะปรากฏหนา้ต่างให้ตั้งช่ือไฟล ์และเลือกท่ีบนัทึกดงัภาพดา้นล่าง 

 

 
 
                        ภาพผนวกที ่จ 17 หนา้ต่าง Save ก่อนการจ าลองใน MIKE21 
 
 คลิกเมนู Run แลว้คลิกเลือกท่ีแถบ Start simulation… 

 

         
 

                                              ภาพผนวกที ่จ 18 เมนู Run  
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เม่ือคลิกเลือกท่ีแถบ Start simulation… จะปรากฏหนา้ต่าง Launch settings ให้
คลิกปุ่ม OK เพื่อท าการจ าลอง 

 

          
 
            ภาพผนวกที ่จ 19 หนา้ต่าง Launch settings 
 


